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Introduction 

TCScan+ is a breakthrough add-on to Worden Brother's TeleChart® Stock Charting 
Program.   Its powerful scanning features will help you find great trading prospects 
quickly and easily. 

Feature Summary 

Trendlines and Channels  TCScan+ automatically finds trendlines and channels in your charts 
and will alert you when price is near a line or has broken it.  You can also find technical analysis 
patterns such as triangles, pennants and 'Rolling Stocks'. 

Patterns TCScan+ finds high-probability Japanese Candlestick patterns as well as other patterns 
like breakout and contrarian ones.  It also allows you to create, edit, test and view your own 
patterns. Formulas are defined using the same language used in TeleChart to create PCFs - with 
some powerful extensions added. 

Correlations  TCScan+ tells you which stocks or indexes are most similar or dissimilar to each 
other.  You can then trade similar stocks off each other, or take opposite positions in dissimilar 
stocks.  You can also use this feature to balance your portfolio - making sure that you have a 
diverse set of items to trade (CorrelScan, free to TCScan+ owners or available as a separate 
purchase, helps you do this in an easy graphical form.)  TCScan+ also allows you to search for 
offsets in stocks or indexes.  You can then determine if any set of items move the same way a few 
days apart from each other, allowing you to get a reliable head-start on a trade. 

Fibonacci Levels  TCScan+ automatically determines Fibonacci levels for your items and alerts 
you when the current price is close to a level.  Fibonacci levels are a fundamental part of Elliott's 
Wave principle, and in many trader's opinions, the most reliable of his principles. Tom DeMark uses 
Fibonacci levels and numbers extensively. 

Support & Resistance Levels  In addition to trendline and channel scans, TCScan+ also provides 
automatic detection of horizontal support and resistance levels.  These levels can be determined 
from either past price or volume action.  

Volatility Stops are one of the most highly-regarded methods of profit protection.  Many traders 
and authors recommend their use, including Market Wizard Van K. Tharp, and we have personally 
found them to be the very best stop method available.  TCScan+ finds either long or short position 
stops, and will allow you to set the degree of risk that you are comfortable with. 

MoneyStream™  Worden's proprietary MoneyStream™ indicator provides an extremely good 
indication of hidden buying or selling.  Of particular importance are divergences between 
MoneyStream™ and Price.  TCScan+ finds these divergences for you, as well as other 
MoneyStream™ characteristics. 

Relative Strength Moving Averages (RSMA) are very useful for determining how an item is 
performing relative to the overall market or to another item.  Larry Williams finds them so useful in 
ranking which items to trade that he has devoted whole chapters of his books to them.  The 
Worden Brother's have spent many of their Notes discussing their use as a long-term exit 
technique.  TCScan+ searches for RSMA crossovers as well as relative RSMA levels, allowing you 
to implement both of these trading strategies. 
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Getting Started 
To help you get started with TCScan+, we describe below the steps needed to find a set of bullish 
stocks whose current price is breaking above a down trendline.  Once you have finished this 
procedure you should have a good base for running the other TCScan+ scan types.  For further 
information please refer to the main Help section.  If you can not find what you are looking for, please 
email us at support@tcscanplus.com 

 
Step 1 - Overview 

To start with, let’s review the regions into which the main form is divided - see the picture below.  The 
yellow region is where you select which of your TeleChart lists you want to scan.  The red and blue 
sections are where you filter your lists by price, volume, exchange type and price/volume trend.  The 
green section is where you select the type of scan you want to run, and the settings for that scan.  The 
white section is where your results will be displayed.  You also have the menu bar at the top of the 
form where you can select actions you want to perform, as well as command buttons underneath the 
results section. 

 

 

Step 2 - Backup Current Settings 

We will first save your current TCScan+ settings to a data file so that when you are finished with this 
exercise you can restore them.  To save your settings, click on the File menu at the top of the form 
and select 'Save Scan Settings'.  Notice that next to 'Save Scan Settings' is listed 'Shift+F11'   This 
means that you can perform the same function by holding down the Shift key then pressing F11. 

A dialog box will appear asking you to enter the name of the file in which you want to save the current 
settings.  Enter 'My Scan Settings' and press the Save button. 



TCScan+ 2.6.7 Help File 

4 

 

For further information on saving your settings see Save Scan Settings 

 

Step 3 - Selecting the lists to scan 

Now that your old settings are saved, we can start setting up the new scan settings.  First we will 
deselect any lists that might currently be in your scan settings, then we will select two lists for 
TCScan+ to scan.  A common question asked by new users is why a scan shows that more stocks are 
being scanned than are in the lists a user has selected.  The usual reason for this is that the user has 
additional lists selected from previous scans that they are not aware of.  Therefore, we recommend 
clearing the list selection area before entering a new set of scan settings, unless you will always be 
scanning the same lists. 
To deselect all lists, click on the List menu then select Clear All Checks - or press the F7 key.  Notice 
that there are many other functions for manipulating the list selection area under the List menu, such 
as finding a list and counting the number of stocks in the lists you have selected. 
Next we will select two standard TeleChart lists to scan: the S&P 100 component stocks and the 
Business Software & Services list.  (If you are using the TeleChart Funds version, you will not find 
these lists - you could choose two other ones instead.) 

For the S&P 100 list, find the main heading 'Worden Brothers Maintained List' in the list-selection 
region.  Click on the '+' next to it to expand the list. 
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Once you have clicked on the '+', then the list will expand to show all the Worden Brothers maintained 
lists.  Move the slider on the right of the list-selection box and find the list titled 'Standard and Poors 
100 Component Stocks'.  Click in the white box to the left of it, which will then become checked. 

  

To make it easy to select the next list, we can 'collapse' the list selection tree, using the Collapse Tree 
command in the List menu, or by pressing the F6 key.  When the tree is collapsed, you will notice that 
the main heading, 'Worden Brothers Maintained List', is highlighted in Blue and Bold - to indicate that a 
list is selected within it.  This highlighting is an easy way to see whether and where lists are selected. 

 

The next list we want to select is located under the 'Main Industry Group Component Stocks' 
heading.  Click the '+' next to this heading, then locate the section titled 'COMPUTER SOFTWARE & 
SERVICES' and click the '+' next to it too. 

 

Finally, move the scroll bar down to find the list titled 'Business Software & Services' and check the 
selection box next to it. 

 

As a final check, select Count Items from the List Menu.  This should show that you have two lists 
selected, and how many symbols are in the list.  At the time of writing, the list count showed the 
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following - but you will probably see something different as the composition of the lists change with 
time. 

 

For further information on list selection and manipulation see Selecting Lists and List Menu 

 

Step 4 - General Filter Settings 

Next we will enter our general filter settings for price, volume and exchange.  The diagram below 
shows the values to enter along with an explanation for each.  Of special note, is that volume is shown 
in 1,000s in TCScan+ not 100s as in TeleChart.  A common mistake for new users is to enter a high 
value for the minimum average daily volume, forgetting that the number they enter is multiplied by 
1,000 - the result is that no stocks can pass the filter. 

 

For further information on general filter settings see Filter Criteria 

 

Step 5 - Scan Type Settings 

We now will enter the settings we need to run the trendline scan.  If the trendline tab (titled 'Trend') is 
not selected then click on it.  If it is not visible, use the scroll buttons to locate it. 
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Now enter the specific trendline settings as shown below. 

 

For further details on trendlines and trendline scan settings see Trendlines.  For your convenience all 
the above settings are stored in the settings file 'Getting Started'.  You can load them by pressing the 
F11 key from TCScan+. 

 

Step 6 - Running the Scan 

Now that the scan settings are entered, all we have to do to run the scan is press the Scan button near 
the bottom of the form, or press the F9 key.  When the scan is running, you will see that the text of the 
Scan button changes to Stop - meaning that you can press the same button to stop the scan (or press 
F9 again.)  The progress of the scan is indicated by messages on the status bar and by the progress 
meter, and stocks passing your filter settings are listed in the results table. 

 

To read about other options when running the scan see Start Scan, Scan Single Item and Scan 
Results. 

 

Step 7 - Reviewing Results 

When the scan is complete, the stocks that have passed the scan settings will appear in the results 
table, and the number of stocks found will be shown on the status bar.  A chart showing the first stock 
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in the list will also be opened.  (If the chart does not appear, then you will need to check the box next 
to Show Charts while Reviewing Results in the Options > Preferences menu.)  You can also get the 
equivalent TeleChart chart to open for the item at the same time, by checking the box next to Open 
item in TeleChart while reviewing results, also in the Options > Preferences menu. 

You can step forward through the stocks in your results by pressing the Space bar, and backward by 
pressing the Backspace key.  Various options are available for manipulating, saving and printing the 
results.  For details see Reviewing Results.  Various options are also available for manipulating the 
TCScan+ charts and adding objects such as lines, circles and Fibonacci lines.  For details see Charts. 

For this example, we will export the set of stocks in your results list to TeleChart. 

 

Step 8 - Saving Results and Exporting to TeleChart 

Method 1: Automatic Transfer (Versions 2.4 and later only) 

To automatically export the items in your results list to TeleChart you select Export Scan Results from 
the File menu or the right-click menu for the results table.  This will open up the form shown 
below.  Enter 'Test List' as the list to export to, leave all the other settings as shown and press the OK 
button. 

 

If this list name already exists, you will be prompted whether you want to add your items to it, 
otherwise a new list will be created.  If a problem occurs during the process, please follow the 
suggestions provided by the messages that appear. 

Method 2: Manual Transfer (Versions 2.3 and earlier.) 

To manually export the stocks to TeleChart you first need to save them to your hard disk.  To do that, 
click the Save button at the bottom of the form, or select Save Scan Results from the File menu.  A 
form will open up allowing you to select saving options - leave them as shown below. 
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Click OK.  A new form will open allowing you to enter a name for your results file.  Enter the name 
'TrendlineScan' and make sure that the type of file is 'Names Only (*.txt)'  Take note where you are 
saving the file to, because you will need to get back there again when we import the file into TeleChart, 
then press the Save button. 

 

Now open TeleChart and create a new watchlist to hold your results.  To do that, select Create New 
Watchlist from the File menu in TeleChart.  A form will open up, looking somewhat like that below, 
depending on the version of TeleChart that you have.  Enter 'Test List' for the list name and check the 
'Import from a file' option button then press OK. 

 

On the next form that appears, navigate to the 'TrendlineScan.txt' file you saved earlier, then press the 
Import button. 
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The stocks you saved will now be entered in your new watchlist, allowing you to monitor them as you 
do with other watchlists, or even include in future TCScan+ scans. 

 

Step 9 - Restoring Previous Settings 

Now that you have completed this scan, you can restore your previous settings (if you like.)  To do so, 
select Load Scan Settings from the File menu, then navigate to, and load, your previously-saved 
settings file 'My Scan Settings'. 

 

Conclusion 

The above sequence of steps should serve you well in running the different scans available in 
TCScan+.  For further details on each of the scan types, click Scan Types, and for details on the 
various commands available see Menus.  For charting features click Charts and for a list for shortcut 
keys for commands select Shortcut Keys. 
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File Menu 

 

Default Settings will clear all general and scan-specific settings (but not preferences) and return 
them to their default values.  

Load Scan Settings (F11) will open the form below, which allows you to load a previously-saved 
TCScan+ settings file.  As you click or move through the files shown in the right-hand pane, 
summary details of the file will be shown in the lower-left pane.  This form also allows you to 
specify how you want the lists stored in the settings file to be loaded.  You can choose to add the 
lists in the file to your current list selection, ignore the lists in the file, or replace your current list 
selection with those in the file.  This setting, as well as the file name you select, will be saved as 
defaults for the next time you load settings again.  To delete a settings file click the Delete button 
on the top right of the file list pane.  To move quickly to your Desktop, Documents or TCScan+ 
Documents directories, click on the buttons above the directory section. 
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Save Scan Settings (Shift F11) allows you to save the current TCScan+ settings in a file that you 
can load later. The TCScan+ settings files have extension '.tcs', and are stored by default in the 
directory in which you installed TCScan+, though you can store them anywhere you like. Double-
clicking one of these files will launch TCScan+ and open the file in it.  It is useful to create a 
number of settings files to handle different scenarios, for example you could create one for 
oversold market conditions, and one for overbought. You could also have a bottom fishing, or 
rolling stock scenario, along with a long term buy and hold scenario. There are a number of 
example settings files included in your TCScan+ directory.  The settings file Last.tcs contains the 
settings that TCScan+ had when it was last closed, or until you unchecked the Save Settings 
preference. The settings in Last.tcs are always loaded when TCScan+ first starts up.  

Start Scan (F9) allows you to start the scan. Once the scan has started, this menu item will 
change to Stop Scan, which will allow you to halt the scan. Clicking this menu item is equivalent to 
pressing the Scan button at the bottom of the TCScan+ form.  

Scan Single Item (Ctrl F9) allows you to run the scan for a single item only, instead of the 
selected lists. Note that all the usual filters apply to this scan, so even though you run a scan for a 
specific item, it might not appear in the results table.  You can select the Ignore Filter option to 
ignore the filter criteria and make sure the item appears in the results table.   

Scan Results (Shift F9) allows you to run the scan for the group of items produced in your last 
complete scan or for a group of items stored in a results file.  For the latter option, you can scan 
either 'Names Only' (TXT) or 'Names and Values' (CSV) files.  You can also use another program 
to create a list of stocks that you can scan.  The file must have a separate name on each line, and 
must have a 'txt' extension.   

Print Scan Results (Ctrl P) will open the form shown below, which will allow you to print some or 
all of your scan results.  Clicking this menu item is equivalent to clicking the Print button at the 
bottom of the main TCScan+ form.  The items in the Data to Print section are equivalent to the 
options shown on the Preferences form.  The Items to Print section allows you to select which 
highlighted or un-highlighted results you want to print.  The Comment Lines textbox allows you to 
specify whether the results list should be printed with empty lines following each item to allow you 
space to write comments later.   

 

Save Scan Results (F12) will allow you to save the information in the results table to a file.  You 
can choose whether to save all your results or only highlighted ones.  You also have two file 
format options for saving:  
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Names only:  Saving only the item names is useful for allowing you to import the results of your 
scan into TeleChart. You do this by saving your results in Names-Only format to the TeleChart 
directory.  Then use TeleChart's Import Symbols from List menu item under the WatchList menu to 
import the list into TeleChart.  

Names and Results:  Saving the results and filter values is useful for reviewing all the data later. 
The file format is a comma separated text file, which is a standard format easily opened in 
Microsoft Excel.  

 

Export Scan Results (Shift-F12) will allow you to export some or all of the items in your results 
list directly to TeleChart(see the form below.)  Other ways of accessing this command are to click 
the L key while an item in the results list is selected or to hold down the Shift key while clicking the 
save button at the bottom of the main form.  TeleChart does not have a direct mechanism to allow 
other programs to cause them to import items, so TCScan+ has had to resort to some advanced 
windows control.  This technique does sometime run into problems, and one of the ways you can 
correct it is by reducing the Batch Size.  This limits the number of items transferred to TeleChart at 
a time and reducing this number normally corrects problems.  If all else fails, however, you can 
always use the manual method described in the Getting Started Guide.  
 

 

 Save Chart Pictures  Selecting Save Chart Pictures will bring up a form allowing you to save 
chart pictures for multiple items in the results list.  You can access the same command from the 
Chart's File > Save Chart Pictures for Results List menu or Save Chart Pictures from the results 
list popup menu.  
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The layout of the form is similar to those above, in that you can choose whether to save pictures 
for all your results or only highlighted ones.  There also are options to provide a naming template 
for the files, the directory where to save them and the file type.  Hovering the mouse over the 
Naming box on the form will bring up popup help on the naming format, as shown below.  As an 
example, if MSFT is in your results list and you use the naming template 'DATE1 SYMBOL' (the 
default) as shown in the above, the file will be called '09-08-08 MSFT.png'.  Note that you can add 
any extra text you like anywhere in the template.  For example changing the naming template to 
'Test Scan DATE1 (SYMBOL - NAME)' will create a file called 'Test Scan 09-08-08 (MSFT - 
Microsoft Corp).png'  

 

 Recent Files List  Contains a list of up to 6 of the last settings files you either loaded or 
saved.  Clicking on one of these items will load the applicable settings file.  

 Register will bring up the registration form, which will allow you to purchase and register 
TCScan+.  

 Exit will close TCScan+.   
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List Menu 

 

 Reload all lists (F5) will signal TeleChart to retransmit all available lists to TCScan+. You 
may need to perform this operation if you have added or deleted lists or symbols after 
TCScan+ has already started up.  

 Clear Checks (F7) will remove all selections from the lists, and collapse the list view. This is 
particularly useful if you have selected a large number of lists, and do not want to uncheck 
each individual item.  

 Find List (F4) will allow you to search for a list name within the list view. The search will start 
at the current position in the tree and search down. The search will try and find what you enter 
in the search box anywhere in the list names in the tree. For example, searching for 'ol' will 
find the lists 'My Portfolio', 'Household Products', etc. Repeated calls to this operation will keep 
on searching down until the end of the tree is reached. You will then be asked if you want to 
start searching at the top of the tree again.  

 Count Selected Items will display the count and names of all the selected lists, and the count 
of symbols within those lists. 

 

 Collapse List View (F6) will collapse the list view so that only the main list types are shown.  

 Expand List View (Shift F6) will expand the list view completely.  
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View Menu 

 

 Results Only (F2) toggles between Full-Form view of TCScan+, and Results-Only view.  In 
Results-Only view, only the results table, menu, and command buttons are visible.  You can 
use the Full-Form view while setting the filter criteria, then use the Results-Only view while 
you are stepping through the results, and viewing charts. Most menu and other items will be 
invisible or disabled while in results-only view. When you switch back to full-form view, they 
will be visible/enabled again.  When the form is in results-only mode it can be resized, so you 
can see more of your results at once.  

 

 Default Size (Shift-F2) Resizes the form to its base scaling.  When you start TCScan+ it will 
open to a predetermined size depending on your screen resolution.  You can then resize the 
form as you like, but can select the 'Base Scaling' command to return it to the size it was when 
you opened TCScan+.  
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 Form Sizing Dialog (Ctrl-F2) Allows you to scale the form interactively, return to the default 
size, and to save the current form size as default.  This functionality is added as an alternative 
to dragging the form's borders to resize it, which does not function with certain video cards.   

 Last Back-Test Statistics will bring up the form summarizing the last back-test statistics.  

 Show Chart (F8) Will open up the chart for the item currently selected in the Results 
Table.  You can also press the Space Bar or BackSpace button to step through the results 
and view the charts, or you can double-click on a row in the results table to display the 
chart.  Note that charts will only be displayed if you have set your preferences to allow their 
display.   

 New Chart - Arithmetic/Logarithmic (Ctrl/Shift-F8) Will open up a chart for a specific item 
name that you enter, using either regular (arithmetic) or logarithmic price scaling for the 
chart.  This item does not have to be in your selected lists to be displayed.  The chart will only 
include the price bars, not any of the indicators for the current scan.  If you want to display the 
chart for a specific item including the indicators for the current scan type, then you should use 
the Scan Single Item Command instead.   
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Options Menu 

The Options menu allows you to open the Preferences form, toggle Ignore-Filter mode and specify 
Back-Test options. These can also be accessed using the F3, Ctrl-F3 and Shift-F3 key combinations, 
respectively.  General options and preferences are described below and back-test options are 
described in a subsequent section of the help file. 

 

 Save Scan settings when program exits causes TCScan+ to save all the current settings to 
the file Last.tcs when the program is closed. This file is automatically loaded when TCScan+ 
starts up again. This file is overwritten each time you close TCScan+. If you uncheck this 
option, then Last.tcs will still be loaded each time the program starts, but the settings in the file 
will be those last written to it before the option was unchecked. If you delete the Last.tcs file 
then TCScan+ will start up with its default settings.  

 Show Tips when hovering over controls allows you to set whether the ToolTips are shown 
when you hover over controls. These tips are useful when you are new to the program, but 
quickly can become irritating when you know what everything means.  

 Don't clear results when settings change  will get TCScan+ to keep your last results when 
you change your scan settings.  TCScan+ normally removes any existing results whenever 
you change a parameter that would affect the scan results.  It does this to prevent you thinking 
that old results apply to your new settings.  

 Change to results-only form size when scan ends will automatically change from Whole 
Form view to results-only form view when the scan ends (or stop is pressed.)  To return to the 
whole form view, select 'Whole Form' from the View menu or press F2.  

 Start results-only form at lower left of screen will cause the main form to start up at the 
lower left of the screen when you switch to results-only mode.  This is useful if you use the 
results-only mode to tab through your scan results while the charts are being opened in 
TeleChart. 
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 Ignore Filter settings during scan will allow you to run the scan while ignoring most of your 
filter criteria.  (This option can also be accessed by double-clicking the Filter Criteria caption 
on the main form or by pressing Ctrl-F3.)  Some criteria can not be ignored, for example the 
lookback period, or else TCScan+ will not know where to start or end the scan!  However, the 
criteria that will be ignored become grayed-out so you know they will be ignored. The Ignore 
Filter option is useful for: 

 Quickly seeing how stocks in a results list look in light of other scan types.  For 
example you could do a pattern scan and find a list of items with bullish patterns.  You 
could then switch to Ignore Filter mode and run a trendline scan on these results to 
see whether trendlines confirm the patterns.  In this case you want all the items in 
your results list to pass the trendline scan, because you just want to see the best 
trendlines, not trendlines that match any specific criteria you may have. 

 Determine useful patterns for you to look at in the future. For example, running the 
MoneyStream scan, you could see what the MoneyStream levels and angles were for 
the best performing items in your list, then use those settings in future scans. 

 Scanning a list of items, for example indices, that have different characteristics from 
the items you normally might scan.  

 Ignore Filter settings when doing a single item scan will cause the filter settings to be 
ignored (see above) when running the scan for a single item.  This is useful when you just 
want to see how the various TCScan+ indicators and patterns look for a particular stock, 
rather than doing a scan to find stocks meeting certain parameters.  If you don't have this 
setting checked when doing a single item scan, then there is a good chart the item will not 
appear in your results (and the chart will not show) unless your item meets all the criteria you 
have specified. 

 Link filter criteria to scan type  when checked, will cause the general filter criteria and list 
selection to be linked to each scan type.  For example, if you tend to run the support level 
scan with a long time period, on daily bars and the rest of the filter settings ignored, but run 
the trendline scan with a short time period and on weekly bars, then using this option will allow 
you to quickly swap between the scan types with the appropriate filter settings linked to each 
scan.  The option of whether to ignore some filter settings is included in this linkage.   

 Open Item in TeleChart while reviewing results allows you to specify whether the items in 
your results list will be opened up in TeleChart as you step through them.  

 Time Delay for TeleChart operations is the amount of time, in seconds, that TCScan+ 
should wait after opening up a chart in TeleChart or transferring objects to TeleChart, before 
taking control back from the system.  This value can be increased if TCScan+ does not 
become selected again after the above operations have completed, for example, while you are 
clicking through the results list and you have the Open in TeleChart option on.  

 Show Charts while scan is running allows you to set whether TCScan+ will open up the 
chart for each item as it passes the filter. Showing the charts while the scan is running will 
slow down the overall scan time.  

 Show Charts while reviewing results allows you to set whether TCScan+ will open up the 
item's chart as you step through the results list. 

 Bar Type allows you to toggle between the candle, OHLC and line type charts.  The same 
change can be made using Change > Bar Type from the chart menu.  Note that the line is 
based on either the average, i.e., (O+H+L+C)/4, price or the close price, depending on 
whether or not you have selected to use close prices for your scan.  In the example below, the 
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trendlines are based on highs and lows, but the line is based on average price, so the 
trendlines appear to float. This would not be the case if the close price was used for the scan. 

 

 

 Show volume bars on charts  will either get TCScan+ to show or not show volume bars on 
the chart.   

 Use Close-Close Coloring  The default method for defining an up volume bar is that the 
current close is higher than the previous day's close.  This is also TeleChart's default.  You 
can uncheck this option to instead define an up bar as one where the current close is higher 
than the current open.  The two methods are equivalent if there are no price gaps.   

 Use logarithmic volume scaling will change to logarithmic scaling for the volume bars.  This 
is useful if there are periods of high volume that drown out the other bars, making it difficult to 
see the trend.   

 

 

 Max % height of volume bars is the maximum percentage of the height of the chart that the 
volume bars will fill.  You can change this to allow the bars to cover more or less space on the 
chart.  If you don't want the volume bars to overlap the price, then you should increase your 
chart's bottom margin.   
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 Shift bars to show  If you are starting the scan in the past by entering a value in Shift on the 
main form, then you can choose to display the data following the scan date by entering the 
number of bars following the scan date to show, in this textbox.  A vertical line will be drawn to 
show the scan date, with the data to the right of this line showing what happened following the 
scan date.  You can also change this value via the chart.   

 Minimize main form when scrolling chart  will cause TCScan+ to minimize the main form 
while you are scrolling through your chart.  As explained in the charts section, TCScan+ 
reruns your current scan each time you use one of the navigation buttons on the chart.  As a 
result, while scrolling you will see changes happening on the main form, which can be 
distracting.  More importantly, however, if the chart is over the main form, then the main form 
will briefly appear above the chart each time a navigation operation occurs.  This is particularly 
distracting while scrolling (i.e. keeping a navigation button depressed.)  Windows also has to 
redraw the main form after each change, which slows down the chart redraw - so scrolling 
takes longer. To prevent this behavior you can choose to minimize the main form while doing 
chart scrolling and also optionally restore the form once the chart scrolling is complete (see 
below.)  Note that TCScan+ will always minimize the main form during scrolling operations if 
the chart is maximized, whether or not you have specified this preference.  

 Restore main form after scrolling chart  This setting will cause TCScan+ to restore the 
main form after is has been minimized during chart scrolling (see above.)  The restoration of 
the form can be distracting so you can just choose to leave the main form minimized until you 
manually restore it.  As described above, when the chart is maximized TCScan+ will always 
minimize the main form during a chart scroll.  It will also not restore it until you restore the 
chart (i.e. "un-maximize" it.)  

 Keep chart docked to main form will keep the chart docked to the main form as it is moved 
around or resized.  Note that the chart will not be allowed to extend off the screen, so the left 
side may be hidden underneath the main form.  To correct this either resize the main form or 
chart.   

 Default to symbol names for chart saves will cause TCScan+ to set the default name for 
chart pictures saves to the symbol name.  Otherwise it will default to the last-saved file name.   
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Help Menu 

 

 Help Topics (F1) will open the main help file.  

 Getting Started Guide will open the help file to the section containing a getting started guide.  

 Show Agreement will display the software agreement you accepted when you first ran 
TCScan+.  

 TCScan+ Website will open your browser and point it to the TCScan+ Website.  

 About TCScan+ will open the About form, which will allow you to see the TCScan+ version 
and get system information.  
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Running a Scan 
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Selecting Lists to Scan 

The top panel on the main form shows the lists that you can select to scan.  These lists are the ones 
found in TeleChart - either created by Worden Brothers or by you as manually- created WatchLists or 
EasyScan lists.   When TCScan+ opens up, the lists are shown in a collapsed state, meaning that only 
the main list types are shown. The list structure is referred to as a tree, with the trunk consisting of the 
main list types, and the branches consisting of sub lists within the main lists.  The List menu contains 
various functions for handling the List Tree. 

 

Clicking on the plus sign next to an item will expand that item, and allow you to select some or all of 
the items within that main list. Clicking on the minus sign next to an opened item will collapse that item. 
The main item heading will show in bold and blue, to indicate that some or all of the items underneath 
it are selected. 

 

Clicking the checkbox next to a main item will select or deselect all the items underneath that item. 
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Filter Criteria 

The sections shown on the picture below constitute the main filter criteria available in 
TCScan+.  Further filtering options are provided on the individual Scan Type sheets, and of course, 
TCScan+ can be used to scan lists that have already been filtered within TeleChart.  For example, you 
could create an EasyScan list in TeleChart that includes only stocks with low P/E ratios, and then use 
TCScan+ to find out when these stocks are near a support.  As an aside, the reverse is true as well. 
You can take the items that pass a TCScan+ scan, and import them into TeleChart. 

 
Closing Price allows you to select the range of closing prices for your filtered items. If you were 
trying to bottom-fish you could set the range low, perhaps from 1 to 5, whereas if you wanted to 
stay away from the cheaper stocks you could enter a higher range. TCScan+ will scan all the 
equities in your selected lists, and will only pass those items that have their latest closing price 
within the range you specify. If you want to ignore closing prices, then set the range very wide, for 
example from 0 to 100,000. You will also need to widen the range if you are scanning a mixture of 
stocks and indices, since most indices are in the 1,000 to 10,000 range. If you have the Ignore 
Filter option set, then the closing price range will be ignored, and the entry boxes will be grayed 
out.  

Price Range allows you to select how much movement the filtered items must have shown over 
the lookback period. TCScan+ searches all the data over the lookback period, finds the highest 
and lowest prices and determines the difference. This result must fall within the two numbers you 
enter. Setting the range allows you to keep out very volatile or very range-bound items. To ignore 
the price range, set the limits very wide, for example from 0 to 100,000.  If you have the Ignore 
Filter option set, then the price range will be ignored, and the entry boxes will be grayed out.  

Average Volume allows you to select the average volume for your filtered items.  The value you 
enter is multiplied by 1,000 to get the actual volume. Note that this is different from the TeleChart
convention, which is to show volume divided by 100. It is helpful to set the volume range to weed 
out either heavily-traded or thinly-traded stocks. The average volume is based on the time frame 
you have selected, so if you are using the Daily time frame this would refer to average daily 
volume.  As a result, if you are trying to filter out low-volume items and are scanning at a higher 
time frame, e.g., yearly, then you will need to adjust your volume range accordingly.  If you have 
the Ignore Filter option set, then the average volume range will be ignored, and the entry boxes 
will be grayed out.  

The Optionable Yes/No checkboxes allow you to specify which of optionable or non-optionable 
(or both) stocks will be present in your results. 

The Exchange section (AMEX/NYSE/Nasdaq) allows you to select the exchanges for your filtered 
items. Indices are not affected by this selection. If you have the Ignore Filter option set, then the 
exchange type will be ignored, and the check boxes will be disabled.  

The Item Type check boxes (Stocks, Indexes, Indicatrs (Indicators) and Mrkt Avgs (Market 
Averages)) allow you to specify which of these items will be included in your scan.  At least one of 
these must be selected. 

The Price Trend section allows you to specify how price must be trending.  You can specify 
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whether price should be going up, down and/or sideways (flat.)  To ignore the price trend, just 
leave all the boxes checked.  Price angles are measured from -100 (straight down) to +100 
(straight up), with 0 meaning sideways.  The value in the Tol (Tolerance) box allows you to specify 
the tolerance or leeway in defining a horizontal line.  This value can vary from 0 to 100.  To explain 
this setting with an example: if you enter a value of 20 in the Tol box, then TCScan+ will consider 
horizontal trends to be those with an angle from -20 to +20.  Upward trends will be for angles 
greater than 20 and downward trends will be for angles less than -20.  You therefore use the Tol 
value not only for horizontal trends, but also to specify the steepness of upward or downward 
trends.  For example, if you only wanted steep upward trends, you could enter a value of 50 in the 
Tol box and check only the Up box.  This would exclude all trends with angles lower than 50.  The 
Bars box allows you to specify over how many bars the trend should be calculated.  

The Volume Trend section allows you to specify how volume must be trending.  The settings are 
similar to those mentioned above under the Price Trend section.  

Time Frame  Clicking the button next to 'Period' will open up a drop-down list that allows you to 
select the time frame (Daily, Weekly, etc.) for the scan.  If the chart is open when you click this 
button, then the time frame for the chart will automatically change as you use the up/down arrows 
to move through the time frame list.  When you have decided on the time frame you want, press 
the Enter key, or click on the time frame desired.  You can also change the time frame by clicking 
one of the 'T' buttons on the chart, or by holding down the Ctrl key and pressing D, W, M, Q, Y, 1, 
2, 3 ... (for Daily, Weekly, Monthly, etc.) while the chart is selected.  

Lookback Period allows you to set how many bars of data to include in your scan. TCScan+ will 
attempt to use this amount of data, or the maximum available data for the items available in your 
list, whichever is shorter.  Increasing the number of bars to include in the scan helps to get the 'Big 
Picture', but also increases the time to scan all the items in your list. Clicking the button just to the 
right of the entry box shows a calendar form that allows you to select a specific start date for the 
scan. 

 
Use the buttons at the top of the calendar to move backwards or forwards in time.  The normal 
movement is one month at a time, but you can hold the Shift key down while clicking to move by 
two months, the Ctrl key to move by 6 months and both the Ctrl and Shift keys to move by one 
year at a time.  When you are in the month of interest, click on the desired date. If TCScan+ 
determines that the date you select was not a trading day, it will suggest the two closest trading 
days for you to enter instead. To scroll faster through the calendar hold down the Ctrl button while 
clicking to scroll by month To close the calendar without selecting a date, press the button to the 
right of the entry box again. 

Shift allows you to select how many bars back you want to start the scan. Starting the scan some 
period back in time is useful for back-testing purposes: You could see what your TCScan+ settings 
would have told you about items in your list at some time in the past and could then review what 
actually happened in the subsequent bars. TCScan+ will use the number of bars of data in the 
'Period' box starting from the bar indicated by the entry in the Shift box. For example, with a 
lookback period of 100 and a shift of 10, TCScan+ will actually be loading 110 bars of data, but will 
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discard the latest 10 bars when doing the scan. Entering a value of 0 in shift lets TCScan+ start 
the scan at the latest date available in TeleChart.  Note that when using a higher time frame, it 
may be necessary to have a non-integer shift period.  This is because the shift period is presented 
in bars, but you could be wanting to start the scan somewhere within a higher time frame bar.

As with the lookback period, you can select a specific date to start the scan by clicking the button 
just to the right of the entry box. You can also click the left and right arrow buttons to the right of 
that to change the shift value by 1 (or 5 if you press SHIFT at the same time, or 25 if you press 
CTRL at the same time.)  If you press these buttons while a chart is open, then the chart will 
automatically be redrawn using the new shift value.  The behavior of these buttons is different 
from those on the chart:  Using these buttons will cause all your other scan results to be removed 
and get TCScan+ to do a single item scan using the new parameters.  The behavior of the buttons 
on the chart are described in the charts section.   
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Starting and Stopping the Scan 

Once you have set the filter criteria and type of scan, you can start the scan by one of three ways: 

 Clicking the Scan button at the bottom of the form  

 Selecting Start Scan in the File menu.  

 Pressing the F9 key  

You can also run the scan on a single item, previous scan results, or a text file containing a list of 
stocks.  These options are available via the File menu or by clicking the Scan button at the bottom of 
the main form. (Clicking Scan will run the scan on the lists you have selected, holding Ctrl down while 
clicking will run a single item scan, and holding Shift down while clicking will run a results list 
scan.)  For single-item scans, you can also click the button marked Single at the bottom of the form. 

Before the scan is started, the Print and Save buttons are disabled, because they serve no function 
until there are items listed in the results table.  Once the scan is started, TCScan+ will fill the results 
table with items that pass your filter criteria.  At the same time, the Scan button will change into a Stop 
button, and the Start Scan menu item will change into a Stop Scan menu item.  You can stop the scan 
at any time by clicking the Stop button, selecting the Stop Scan menu item, or pressing the F9 key 
again.  When the scan is finished, the Print and Save buttons will be enabled to allow you to print and 
save the results in the table. 

 

While the scan is running, you may review your results graphically by selecting that preference.  When 
the scan is finished, you can review your results. 
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Scan Types 
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MoneyStream Scan 

We have found Worden's MoneyStream indicator  to be an extremely useful indication of accumulation 
or distribution of an item.  Of particular usefulness are divergences between MoneyStream and 
Price.  If the MoneyStream starts climbing and the price stays flat, or if the price starts falling and 
MoneyStream does not, it is a good probability that there will be a price climb in the near future.  The 
reverse hold true as well - if price climbs strongly, but MoneyStream does not follow, then there is 
likely to be a price collapse soon after. 

Details on MoneyStream are found in the TeleChart user manual, and a video training course is also 
available through the TeleChart Website.  TCScan+ will help you implement the strategies you learn 
from these sources, as they can not be fully-automated in the current version of TeleChart. 

MoneyStream Scan Parameters 

The MoneyStream Tab allows you to set the parameters for your MoneyStream scan.  You can check 
boxes to select whether to scan for MoneyStream Angles, Levels, and divergences in Angles and 
Levels.  You can then set the limits for these parameters.  

 

The figure below illustrates the meaning of the various MoneyStream Scan parameters - a description 
is provided below. 
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TCScan+ helps you find two types of divergences:  (You can search for either or both at the same 
time.)  
 

1. Level Divergences: Is the MoneyStream at a higher historical level than price at this point in 
time, or vice-versa?  

2. Angle Divergences: Is the MoneyStream rising faster or slower than Price at this point in 
time?  

 

For Level Divergences, TCScan+ searches back over the Lookback Period you specify and 
determines the highest and lowest value for MoneyStream and Price.  The Low and High are then 
assigned values of 0 and 100, and the values in between are scaled accordingly.  Therefore, if you run 
a scan for MoneyStream levels from 50 to 100, you are specifying that the current MoneyStream level 
must fall in the top 50% of the range of MoneyStream values over the lookback period.  The difference 
between the levels of MoneyStream and Price is the Level Deviation.  For example, in the graph 
above, the latest MoneyStream value is at 88% of the lookback range, while the price is at 46% of the 
lookback range, so the level deviation is 88 - 46 = 42.  This is a positive deviation because the 
MoneyStream level is higher than the Price level. 

For Angle Divergences, The MoneyStream and Price angles are calculated over the previous number 
of bars you specify in the box next to Angle Deviation.   Upward sloping lines have an angle from 0 to 
90 (straight up), and downward sloping lines have an angle between 0 and -90 (straight down.) 

You can search for MoneyStream angles within a range and for deviations between the MoneyStream 
and Price angles.  If the MoneyStream Angle is higher (more counter-clockwise) than the Price Angle 
then there is a positive angle deviation, and if the reverse is true, then there is a negative angle 
deviation. 

To summarize, the parameters you can set are as follows: 

MS Angle Range  The range of MoneyStream angles (slopes) to find.  The range is -90 (straight 
down) to 90 (straight up.)  The period over which to calculate the angle is entered in the box next 
to Bars to the right of the Angle Deviation box. 

Angle Deviation specifies the minimum difference between price and MoneyStream angles.  This 
number should always be positive - you specify the type of deviation by clicking on one of the 
Deviation option buttons. 

Level % Range specifies the range of MoneyStream levels to find, with the values measured as a 
percentage of the range of MoneyStream activity over the lookback period. 

Level Deviation specifies the minimum difference between price and MoneyStream levels.  This 
number should always be positive - you specify the type of deviation by clicking on one of the 
Deviation option buttons. 

Deviation  Select one of the option buttons to specify the type of deviations to find. 

Use Close  Selecting this will cause the MoneyStream to be compared to the close prices instead 
of the average of the open, high, low and close. 

Find Breakouts  Selecting this checkbox will get TCScan+ to find breakouts in MoneyStream.  It 
looks backwards in time at MoneyStream, finding the maximum value over a period varying in 
length between 20 and 60 bars, determined according to MoneyStream volatility.  It then alerts 
you when the current MoneyStream value rises above the maximum value.  When this checkbox 
is selected, the above parameter entry boxes are disabled, because they are not relevant to the 
breakout scan. 

Log Scaling checking this box will cause TCScan+ to use Logarithmic Scaling (instead of the 
normal Arithmetic Scaling) for the charts.  When using logarithmic scaling you will notice that the 
price axis numbers on the chart do not increase linearly, but rather proportionally.    
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Typical Settings 

Long Positions We have found the best long opportunities searching for positive deviations in 
angle and level greater than 10, MoneyStream Level between 25 and 100, and MoneyStream 
Angle between  -10 and 90 degrees, with the angle bars set between 15 and 30.  We suggest you 
screen any items that pass your scan with additional indicators, for example 5-3 and 20-5 
stochastics to determine overbought/oversold conditions. 

Short Positions We have found good-probability shorts using negative deviations in angle and 
level greater than 10, MoneyStream Level between 0 and 50, and MoneyStream Angle between -
90 and 20 degrees.   

Results Table 

Depending on the options you check on the MoneyStream tab, the results table will have between 1 
and 5 columns.  The column headed 'Name' lists the names of the items that passed your filter 
criteria.  The column headed 'Level' is the MoneyStream level, 'L Dev' is the difference in levels 
between the MoneyStream and Price, 'Angle' is the MoneyStream Angle, and 'A Dev' is the difference 
between the MoneyStream and Price Angles.  Note that the values in 'L Dev' and 'A Dev' will be 
positive numbers unless you have the Ignore Filter option set.  Their type of deviation is given by 
whether you selected the Positive or Negative option buttons.  When you have the Ignore Filter option 
set, then the Positive and Negative option buttons are ignored, and the 'L Dev' and 'A Dev' values will 
be shown as positive or negative, indicating positive or negative deviation.  PTrnd and VTrnd show the 
price and volume trend slopes respectively.   'Range' is the price range (highest high - lowest low) over 
the period of the scan.  
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MoneyStream Scan Examples 

Following are some long and short examples from a MoneyStream Scan for September 29, 2000.  We 
chose this day, because the DJ-30, SP-500 and COMPQX indexes were all poised for major drops 
from this day through Mid October - yet a MoneyStream divergence scan still found very good long 
candidates on this day (as well as short ones too).  MoneyStream is shown in Blue and Price bars in 
Gray, with the Price angle line in Red.  The vertical dotted line shows the day of the scan, with the plot 
to the right of this line showing what happened over the next 20 days. 
  
Note the strong positive divergences in levels and/or angles in MoneyStream and Price for the long 
examples, and negative divergences for the short examples.  As in all good trades, judicious use of 
stops would have allowed good profits in either direction over the next few days.  
  
  
Long Examples 
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Short Examples 
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The real degree of divergence is obscured somewhat by the inclusion of the days following the scan 
date on the chart.  For example, the angle divergence for 'C' and level divergence for 'HD' above do 
not appear very large because of the big drop following the scan date.  The charts below show how 
the charts looked on the day of the scan - the divergence is much more obvious.  
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RSMA Scan 

Relative Strength Moving Averages (RSMA) are very useful in gauging how one item is performing 
relative to another item.  They are calculated by dividing the price of the item by the price of the 
reference item, and then calculating a moving average of this ratio.  They allow one to quickly 
separate items into ones performing better or worse than the reference item. 

The Worden Brothers have discussed the use of RSMAs as a long-term profit protection method in 
their February 2000 Worden Notes, and we think they are very useful for this purpose.  However, our 
preferred use of RSMAs is as a trading filter - we take long positions in an item when the short term 
RSMA is above the long-term RSMA and vice-versa. 

RSMA Scan Parameters 

The RSMA Tab allows you to set the parameters for your RSMA scan.  You can select a reference 
index from the drop-down box, or you can type in any item you wish to be the reference.  You can then 
set the period of the two moving averages, their smoothing type, and their relative position.  If you 
selected the Use Close Prices box, then the RSMAs will be based on the close price instead of the 
average price (of the open, high, low and close.)  You could also select the Ignore Filter option, which 
will disable the position drop-down box, to find the relative positions of all the items in your 
lists.  Checking the Log Scaling box will cause TCScan+ to use Logarithmic Scaling (instead of the 
normal Arithmetic Scaling) for the charts.  When using logarithmic scaling you will notice that the price 
axis numbers on the chart do not increase linearly, but rather proportionally.    

 

Typical Settings 

The Worden Brothers favor watching 10 and 40 day simple RSMAs, but we have found wider-spaced 
moving averages more effective - you should experiment and see what suits your trading style 
best.  We like to use Fibonacci numbers as periods for our indicators, typically separating the one 
period from the other by two Fib numbers.  So for example on a short-term basis we would watch a 3 
day RSMA versus a 13 day RSMA, and for longer-term trading would watch a 13 day RSMA versus a 
55 day RSMA.  You could choose other combinations from the Fibonacci series: 1, 2, 3, 5, 8, 13, 21, 
34, 55, 89, 144, etc.  As an example, see the use of 8/55 RSMAs on the long-term chart of AAPL on 
the next page versus the use of 3/13 RSMAs during short-term moves. 
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We tend to use exponential moving averages more often than simple moving averages, but don't have 
a strong preference either way.  Exponential averages are typically more responsive, but less smooth 
than simple moving averages and vice-versa.  We prefer trading the Nasdaq, so use COMPQX as our 
reference, but you could use the SP-500 as a more-general index for large caps, or the RUT-X for 
small caps.  

Results Table 

The column headed 'Name' lists the names of the items that passed your filter criteria.  If you have 
selected the Crossing Above or Crossing Below scan type then a column headed either '% Above' or 
'% Below' will list the percentage that RSMA 1 is above or below RSMA 2.  If you have selected the 
Ignore Filter option, then a column headed '% Diff' will list the percentage difference between RSMA 1 
and RSMA 2.  Positive numbers in this column indicate that RSMA 1 is above RSMA 2, and negative 
numbers indicate that RSMA 1 is below RSMA 2.  PTrnd and VTrnd show the price and volume trend 
slopes respectively.  'Range' is the price range (highest high - lowest low) over the period of the scan.  
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RSMA Scan Examples 

Following are some long and short examples using exponential RSMA crossovers.  The charts show 
data from March 1, 1999 through June 19,2000, and illustrate how useful the RSMAs are as trading 
filters, and also as a long-term profit-protection method.  The charts are based on crossovers of an 8 
day exponential RSMA and a 55 day exponential RSMA, and are calculated relative to the SP-500. 

Long Examples 
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Short Examples 
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Trendline Scan 

Trendlines are one of the most important tools of Technical Analysis, yet are quite simple in 
construction.  They are drawn by connecting a series of recent lows or highs with a straight line.  It is 
amazing to watch stocks repeatedly bounce off a trendline, and then fall or rise dramatically when they 
break this trendline.  When both upper and lower trendline are drawn, patterns appear in the charts 
which can be interpreted with Technical Analysis principles, for example, descending triangles typically 
break down. 

Trendlines and chart patterns should form a large part of your trading arsenal, and we strongly 
recommend that you study books such as "Encyclopedia of Chart Patterns" by Thomas Bulkowski and 
John Murphy's "Technical Analysis of the Financial Markets."   

A major problem with trendlines is that they are often subjective - different people can look at the same 
chart and draw quite different lines.  Furthermore, until you actually draw trendlines on the chart it is 
easy to miss them, and thereby miss potentially-profitable trades.  TCScan+ solves these problems by 
always drawing the trendlines in a systematic, objective manner.  Furthermore, it creates upper and 
lower trendlines for all the items in your selected lists, and lets you know when the price is close to one 
of the lines.  You then have a shortlist of high-probability trades to consider, rather than your whole list 
to click through, manually looking for trendlines.  

Trendline Scan Parameters 

The Trendline Tab allows you to set the parameters for your Trendline scan.  You can specify 
parameters for both the upper and lower trendlines, and also how the trendlines relate to each 
other.  For each trendline, you can define its trend, how long or short it should be, how many touches 
are needed to create it, whether it has been broken (violated), and whether to check for proximity near 
it.  There are also a number of advanced settings that allow you to fine-tune the type of trendlines to 
find, and how to display them on your chart.   

 

Up/Down/Flat  You can check any or all of these checkboxes to find upwards, downwards or 
sideways sloping lower or upper trendlines.  The box following the 'Flat' checkbox is used to 
specify the tolerance for what creates a horizontal trendlines.  This tolerance parameter is also 
applicable to the 'Up' and 'Down' sloping checkboxes too, as described in the Price Trend section.

Broken + Unbroken  clicking this label will open a form allowing you to specify whether the 
particular trendline can be broken or unbroken, and if broken, when it is allowed to have been 
broken. If you don't care where the break occurred, then set this level equal to the lookback 
period.  Check the box 'Use close prices for break check' if you only want closes above or below 
the trendline to count as a break (in other words intraday crossings do not count.)  
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Minimum Length specifies the shortest length the trendline should be.  It helps you to specify 
longer versus shorter-term trendlines.  For example the two charts below show the best trendlines 
found, with and without a minimum length setting.  

 
Maximum Length specifies the maximum length the trendline can be.  You specify whether to 
use this parameter by checking or unchecking the checkbox next to the parameter value box.  If 
you don't use this setting, then TCScan+ will find the best trendline it can, allowing it to be as long 
as the amount of data you have on the chart.  This parameter is useful if you want shorter-term 
trendlines, but also want to see longer term price data.  For example the two charts below show 
the trendlines found with and without a Maximum Length setting of 50 bars.   
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Min Touches specifies the minimum number of touches to the trendline.  Generally, trendlines 
that are touched more, are more reliable.   

Alert Proximity% specifies how close the current price must come to the trendline, in percent, for 
you to be alerted of that fact.  For example, if today's price is 48.0 and the value of the trendline for 
today is 50.0, then the percentage distance between the two is 4%.  If you had your 'Alert 
Proximity %Dist' value set at 5, then you would be alerted to this proximity, because 4 is less than 
5.  If you want to ignore this setting then leave the box empty.   

Log Scale checking this box will cause TCScan+ to use Logarithmic Scaling (instead of the 
normal Arithmetic Scaling) for trendline construction and charts.  When using logarithmic scaling 
you will notice that the price axis numbers on the chart do not increase linearly, but rather 
proportionally.   

Slopes clicking this label allows you to specify the relation between the slopes of the upper and 
lower trendlines.  This is useful in finding chart patterns.  For example to find symmetrical 
triangles, you would want the slopes of the upper and lower trendlines to be opposite.  If you 
wanted to find flags or channels, you would want the slopes to be equal (parallel.)  
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Advanced Trendline Settings 

Clicking the button marked "Advanced Settings" on the trendline tab brings up the Advanced Settings 
Form, which allows you to fine tune your trendline scan, and choose how to display the 
trendlines.  Shown below is a copy of the advanced trendline options form.  Details on each item can 
be found in the help file.   

 

The trendline ranking settings are particularly useful in fine-tuning the types of trendlines to find.  For 
example, the two charts below show the lines found using either the "Short Term" or "Long Term" 
example settings, with all other parameters the same. 
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Typical Settings 

A number of example settings files are included in the TCScan+ directory.  You can access them by 
pressing the F11 key from TCScan+ (or using File > Load Scan Settings.) 

For short-term trades, we recommend setting the Minimum Length to 0, Maximum Length to 20, and 
using the example Short Term Ranking settings.  For longer-term trades you can use a Minimum 
Length of 20, a Maximum Length of 100 (or don't specify a Maximum Length at all) and use the 
example Long Term Ranking settings.  These settings files are stored in your TCScan+ directory 
under the names 'Short Term Trendlines' and 'Long Term Trendlines'.  You can load them using the 
Load Scan Settings Command.  The charts below show the lines produced for the same data set 
using the two different settings. 

 

Remember that with all trades, you should have a very clear idea of where your stop is before you 
execute the trade - we have seen cases where there is a good break up through an upper trendline, 
lasting for a few days, followed by a dramatic breakdown all the way through the lower trendline.  If 
you held onto your initial long position taken after the up break you could lose big-time.  Instead, 
always be ready to go the other way if the market tells you to do so - and use stops! 

To get a feeling for how the parameters affect trendline construction, we suggest you create a list in 
TeleChart with 5 to 10 stocks, and run the Trendline scan with different parameters.  When doing so, 
set the Alert Proximity% parameter to 1000 (to display all items in your list with valid trendlines, now 
matter how far the current price is from those trendlines.)  You can then experiment see how 
parameter changes affect the trendlines drawn. Here are a few more examples showing the same 
chart with different settings:  
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Results Table 

The column headed 'Name' lists the names of the items that passed your filter criteria, and are near 
the upper or lower trendline.  The column headed 'UTL' contains the current position of the upper 
trendline, while the one headed 'LTL' contains the current position of the lower trendline.  You could 
also get these numbers by running your cursor over the chart for the item.    'LTA' and 'UTA' are the 
angles of the lower and upper trendlines respectively.  'PTrnd' and 'VTrnd' show the price and volume 
trend slopes (angles) respectively.  'Range' is the price range (highest high - lowest low) over the 
period of the scan.   
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Trendline Scan Examples 

Following are some examples of trendline scans with different lengths and periods.  The vertical dotted 
line shows the day the scan was run, and the points to the right of the line show what happened when 
the trendline was broken or touched.  We believe that trendline breakouts are one of the highest 
probability trades there are. 
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Channel Scan 

Channels are similar to trendlines, but whereas upper and lower trendlines can be at any angle to 
each other, the upper and lower channel lines are parallel to each other.  The Trendline scan will find 
channels as part of its larger scan, but if you want to scan for Channels only, for example if you are 
interested in rolling stocks or options, then you can use the Channel scan instead.    

Channel Scan Parameters 

The Channel Tab allows you to set the parameters for your Channel scan.  You can specify whether to 
find upward, downward or horizontal sloping channels, and set parameters such as the maximum 
length of the channel, how many touches to the channel lines must have occurred in the past and how 
wide the channel can be. 

 

Channel lines are constructed differently from trendlines, so the parameters have a slightly different 
meaning than those described in the trendline section.  Channels are created by drawing a straight 
line that best fits all the data for the past number of bars defined by the Length and Leeway Values 
(see below.)  Upper and lower channel lines are then created above and below this center line.  The 
distance of the channel line from the center line is set by the maximum distance between the center 
line and price over the length of the channel.  The price considered is either the High and Low, or the 
Close only, depending whether you have checked the Use Close Prices box. 

Slope Up/Down/Flat  Checking either of these boxes will cause TCScan+ to search for upwards, 
downwards and/or sideways sloping channels.  You must check at least one of these three 
checkboxes for the scan to run.  The textbox to the right of the 'Flat' checkbox is the sensitivity (0 
to 90) used in determining if a line is flat.  A value of '0' will cause only perfectly flat lines to be 
found, but when searching for flat lines, you should rather allow some degree of tolerance, e.g., 5-
10 to allow for lines that are almost flat.  This setting is also applicable to the 'Up' and 'Down' 
sloping checkboxes too.  For example, if you enter a value of '20' and then select only the 'Up' 
checkbox, only steeper up-sloping lines will be found (because lower-sloping ones will be 
considered flat.)  

Find near Upper/Lower  Check one (or both) of these two boxes to select whether price must be 
near the upper or lower channel lines.    

Max Length is the maximum number of bars used to construct the channel.   

Max Leeway allows TCScan+ to find the best-fitting channel within the period specified by your 
Max Length and Max Leeway settings.  The channel length is adjusted on the left side by up to the 
leeway amount and the length that provides the best channel is used.  The channel is also 
adjusted on the right hand side, but in that case by the amount specified on the broken/unbroken 
form, and only if you have allowed broken lines (see below.)  So, as an example, if you have a 
Max Length of 60, a Max Leeway of 20, and a broken days setting of 5, it is possible to have a 
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channel created that is only 35 bars long.  Note that the length of the channel drawn on the Chart 
will always be equal to the value in Length, though it may not be based on all the data over which 
the channel is drawn, because of the Leeway parameter.  The actual data used to determine the 
channel will be highlighted by the channel lines drawn thicker in that region. An example is shown 
below.  Both are for a 100 day lookback period and 80 day channel, but the left one was run with a 
60 day leeway, while the right was run with no leeway.    

 

 

 
Min Range% and Max Range% specify the minimum and maximum range of the channel as a 
percentage of the average price along the channel.  For example, if the top of the channel is at 
120 and the bottom is at 105, then the range is 15.  If the average price along the channel is 110, 
then the percentage range is 15/110 = 13.6%.  If you had a Min Range setting below this value, 
and a Max Range setting above it, then the channel would pass your scan (depending on other 
settings too.)  These settings are useful for making sure that very narrow or wide channels are not 
found.  An example of its use can be found in the example settings file for 'Rolling Stocks' included 
in the TCScan+ directory.  Press F11 from TCScan+ to open it 

Min Touches specifies the minimum number of touches to the channel lines.  This number is the 
total for both the upper and lower channel lines.  Generally the more touches, the more significant 
a channel, so settings a higher Min Touches value should find better channels.    

Alert Proximity % specifies how close the current price must come to the upper or lower channel 
line for you to be alerted of that fact.  The calculation method is the same as that described 
above.  For example, if today's price is 48.0 and the value of the upper channel line for today is 
50.0, then the percentage distance between the two is 4%.  If you had your 'Alert Proximity %' 
value set at 5, then you would be alerted to this proximity, because 4 is less than 5.  If you want to 
ignore this setting then leave the box empty.   

Use Close Prices will cause the channels to be calculated based on the close price of each bar, 
rather than the high or low. 

Log Scaling checking this box will cause TCScan+ to use Logarithmic Scaling (instead of the 
normal Arithmetic Scaling) for channel construction and charts.  When using logarithmic scaling 
you will notice that the price axis numbers on the chart do not increase linearly, but rather 
proportionally.   

Broken/Unbroken  clicking this button will open a form allowing you to specify whether the upper 
and lower channel lines can be broken or unbroken, and if broken, when they are allowed to have 
been broken.  The length of the period over which the channels are allowed to have been broken 
is used as the right-hand side leeway for the channels.  See the two examples below, which show 
the same stock with different broken/unbroken settings.  Click the checkbox 'Use Close Prices for 
Cross Check' to only count closes above/below the channels lines as a cross (in other words, 
intraday crosses of the lines are not counted.) 
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Advanced Options 

Clicking the button marked Advanced will bring up a form allowing you to specify advanced options. 

 

 Proximity to line that will be considered a touch (%)  specifies how close the price must come 
to the upper or lower channel line for the price to be considered a touch, measured as a 
percentage of the price.  For example, if at a particular point the upper channel line value is 50.0 
and the price is 49.75, then the percentage distance between the price and upper channel line is 
0.5%.  If 'Touch Prox%' is set at 1 then this point would be considered a touch to the channel, 
because 0.5% is less than the 1.0 Touch Proximity Percentage.   

 Proximity to line that will be considered a touch (absolute) is identical in concept to 'Touch 
Prox%' described above, but in this case the proximity is measured in absolute terms rather than 
in percent. It is useful to have a touch defined in terms of both percentage and absolute value.  As 
an example: for a $100 stock, a 1% Touch Proximity would be ±$1, but for a $1 stock that would 
translate to ±$0.01, which is a very tight tolerance.  Therefore to handle low value stocks you 
could enter the minimum tick value into the  Absolute Proximity. 

 Use chart range for proximity calculations will use the chart range as reference for proximity 
calculations, otherwise the channel line will be used as reference. 

 Show touches to channel lines will select whether to have small arrows shown on the chart 
where price touches the channel lines.  Examples can be seen in charts above.   

 Ensure touches to both upper and lower channel lines  will only allow channels that have 
touches to both channel lines.  Because TCScan+ finds the best channel by first finding the best 
center line through the past data and then works out how to place the channels around it, it is 
possible that one line could end up without any touches to it.  An alternate method is therefore 
available, which will ensure touches to both lines.  An example of the same chart with the two 
different options applied is shown below.  
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 Split minimum touch setting between lines  will help prevent instances where there are many 
touches to one channel line and one or a few to the other - it helps prevent better-formed 
channels.  The difference is sometimes subtle, but usually better - see the examples below.  

 

Typical Settings 

The channel length is usually set in proportion to the lookback period and a large leeway is specified, 
typically in the 80-90% range.  For example, with a 100 day lookback, we would set the channel length 
at around 80 to 90 days and the maximum leeway around 60 to 70 days.  The Length value is not as 
important as the fact that we prefer to make the Leeway a high proportion of the Length.  For example, 
if we were trying to find channels of length 20, we would make the Leeway value between 10 and 
15.  Setting the Leeway high gives TCScan+ maximum ability to find a good-fitting channel.  Note that 
we prefer to set a higher minimum Number of Touches for the Channel Scan than the Trendline Scan, 
because the number of touches in this case applies to both the upper and lower channel lines.  A 
setting of 4 here means that there should be at least four touches to the channel lines, which could 
mean 3 touches to the top and 1 to the bottom, or 2 to the top and 2 to the bottom, or none to the top 
and 4 to the bottom, etc.  However, to prevent the latter case, we leave the Ensure touches to both 
upper and lower channel lines and Split minimum touch setting between lines advanced options 
checked. 

As with the Trendline Scan, we suggest you create a list in TeleChart with 5 to 10 stocks, and run the 
Channel scan with different Length and Leeway values to get a feel for how these parameters affect 
channel construction.  Leave the Alert Proximity % parameter empty during these tests to display all 
items in your list with valid channels, no matter how far they currently are from the channel lines. 

As described above, you can press the F11 key from TCScan+ to load one of the example settings 
files, for example ‘Bullish - CH - Rolling Stock at Support' and ‘Bullish - CH - Channel Break Out’. 
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Results Table 

The column headed 'Name' lists the names of the item that passed your filter criteria, and are near the 
upper or lower channel line.  The column headed 'UCH' contains the current position of the upper 
channel line, while the one headed 'LCL' contains the current position of the lower channel line.  You 
could also get these numbers by running your cursor over the chart for the scanned item.   'Angle' is 
the angle of the channel lines, while 'PTrnd' and 'VTrnd' show the price and volume trend slopes 
(angles) respectively.  'Range' is the price range (highest high - lowest low) over the period of the 
scan.   
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Channel Scan Examples 

Following are some examples of Channel scans.  They show the two modes of trading channels: 
taking trades off bounces from a channel and also breakouts from the channel itself. 
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Fibonacci Level Scan 

Fibonacci levels are an extremely useful way of predicting turning points for your items - it is almost 
uncanny to see how accurate they often are.  Many traders use them religiously, including the well-
known Tom DeMark, and they are an important part of the Elliott Wave Theory - in fact we and others 
believe them to be the most usable and reliable part of Elliott Wave Theory.  A good starting point for 
learning about Fibonacci levels in trading is Robert Fischer's books Fibonacci Applications and 
Strategies for Traders and The New Fibonacci Trader: Tools and Strategies for Trading Success.   

Fibonacci levels are determined by applying Fibonacci ratios to pivot lines. 

Fibonacci Numbers  A series of numbers first studied by an Italian mathematician, Leonardo 
Pisano, but nicknamed Fibonacci, around 1200.  They are determined by starting with zero and 
one, and then adding the preceding two numbers to determine the next number in the series.  So, 
0+1=1 is the next number followed by 1+1=2, then 1+2=3, then 2+3=5, then 3+5=8, then 8+5=13, 
and so on, leading to the series 0, 1, 1, 2, 3, 5, 8, 13, 21, 34, 55, 89, 144, etc. 

Fibonacci Ratios  An interesting feature of the Fibonacci numbers is that as the numbers in the 
series get larger, the ratio of one number divided by the previous number approaches a constant 
value of 1.618, and the ratio of one number divided by the next approaches a constant value of 
0.618. (Actually theses numbers are never-ending, like Pi, but are shortened to 1.618 and 0.618 
for simplicity)  These are the only numbers whose inverse is equal to itself plus or minus one 
(1/1.618=1.618-1=0.618 and 1/0.618=0.618+1=1.618)  Other ratios are also important in trading, 
for example 0.382 (1-0.618), 2.618 (1/0.382), and 4.236 (1 / 0.618×0.382) 

Pivot Lines are lines drawn from a recent high to a recent low, or vice-versa. 

Fibonacci numbers and ratios are found throughout nature, for example in the structure of snail shells, 
the layout of sunflower seeds, leaves and petal arrangements, and even in the proportions of the 
pyramids.  It is not surprising that they are therefore also found in the charts of items. 

Two types of Fibonacci levels are typically found: Price Levels and Time Levels - TCScan+ will allow 
you to find both. 

Price Levels 

The Fibonacci Ratios are applied to the height of the last pivot line, and the resultant values are added 
to the end of the pivot line, as shown by the horizontal cyan lines below - the price fails at the 161.8 
extension (blue line) of the previous pivot (red line.) 
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Time Levels 
  
The Fibonacci Ratios are applied to the width of the last pivot line and the resultant values are added 
to the end of the pivot line, as shown below. 
  

 
  

  

Many of the levels are important, but we have found the 161.8 and 261.8 levels to be most 
reliable.  Also important are the 0 and 100 levels in Price Level scans, as support and resistance, 
respectively, even though these are not strictly Fibonacci Ratios.  TCScan+ will work out a series of 
Fibonacci levels for all the items in your list, and will alert you when an item is near to one of its 
Fibonacci Levels.  The issue of when to trade on Fibonacci Level touches is a complex one and we 
strongly recommend you obtain Robert Fischer's Fibonacci Applications and Strategies for Traders to 
help you in your trading decisions.  

Note that you can also draw your own Fibonacci Price level lines on any chart.   

Fibonacci Level Scan Parameters 

 

Trend Change is used to determine the pivot lines for your items.  It specifies by what percentage 
price must retrace before the previous turning point is considered a pivot.  The lower the 
percentage, the more numerous and shorter the pivot lines will be and vice-versa.  For example 
see the charts below with pivot lines based on 10% and 20% trend changes respectively. 
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Use Range Checking this box will cause TCScan+ to use the range (highest high minus the 
lowest low) of the data in the lookback period as the denominator for the percentage in 
Minimum % for Trend Change, instead of the absolute price.  This option tends to provide more 
uniform pivot lines - you should experiment with using or not using this option on a few items to 
see which you prefer. 

UpTrend/Downtrend allows you to specify whether the price trend since the last pivot line should 
be up or down. 

Price/Time Proximity % specifies how close the price must be to a Fibonacci level, in percent, for 
you to be alerted.  If you want to ignore these settings then leave the boxes empty - this would 
cause the results to show no matter how far the current price is from the level. 

Levels  You can check some or all of the checkboxes in the list of levels to find touches to those 
Fibonacci levels.  An easy way to select is to move up and down the list with the arrow keys, then 
press the space bar to change the selection.  Note that the levels in the list can be changed, 
added to and deleted to by right-clicking any level within the list.

 

Log Scaling checking this box will cause TCScan+ to use Logarithmic Scaling (instead of the 
normal Arithmetic Scaling) for Fibonacci level construction and charts.  When using logarithmic 
scaling you will notice that the price axis numbers on the chart do not increase linearly, but rather 
proportionally.  Note that using logarithmic scaling for Fib level construction is not common, or 
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necessarily correct, however, we have found it useful and valid when looking at longer time 
frames.  

Advanced Options Clicking the Advanced Options button will bring up a form containing 
additional settings for the scan.  In particular you can specify whether any levels found must be 
intact or not, i.e., they must not have been crossed by price since the last pivot line.  A sensitivity 
parameter is included to help specify what would constitute a break.  A value of '0' would mean 
absolutely no break allowed, whereas a higher value would allow a small break to occur. 

 

 

Typical Settings 

Some example settings files are included in the TCScan+ directory.  Press the F11 key in TCScan+ to 
open them (or use File > Load Scan Settings.)  For long term levels, use a high Trend Change% value, 
like 40, and specify a longer lookback period, like 250.  For shorter term levels use a shorter lookback 
period (100) and a smaller Trend Change% (20).  In both cases, have the 'Use Range' box 
selected.  For Price Levels, we typically only look for touches near the levels 0, 100, 161.8 and 261.8 - 
though 361.8 and 423.6 are sometimes also useful.  For Time Levels, the 61.8 level is most important, 
followed by 161.8 and 261.8.  You can also experiment by changing the Time Level numbers (see 
above) to other numbers, such as 50,100,150,200, etc. to look for cyclic behavior in stocks.  These 
settings would find prices near half and full cycle lengths from the last turning point.  

Results Table 

The column headed 'Name' lists the names of the items that passed your filter criteria.  The column 
headed 'P Lvl' contains the Fibonacci Price level that the current price is closest to, and the column 
headed 'P Val' is the actual value of that level.  The column 'T Lvl' lists the closest Time Level and the 
column 'T Val' lists how many bars the current price is before (negative numbers) or after (positive 
numbers) the Time Level.  PTrnd and VTrnd show the price and volume trend slopes respectively.  
'Range' is the price range (highest high - lowest low) over the period of the scan. 
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Fibonacci Level Scan Examples 

Following are some examples of Fibonacci Level scans with different time periods.  We have mostly 
presented examples showing turning points at 1.618 and 2.618 extensions, because we believe these 
are the most reliable Fibonacci trades.  Note that the Fibonacci levels are determined days or weeks in 
advance of the actual move.  The vertical dotted line shows the day of the scan, and the price curve to 
the right of it shows what happened on the subsequent days. 
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Correlation Scan 

The correlation scan allows you to find items that act very similarly or dissimilarly to each other.  There 
are a number of ways to use this information: 

You can trade sets of similar stocks off each other.  If one has good news and breaks out, you can 
trade closely-correlated stocks to it, knowing that they will move in a similar way very soon 
thereafter.  If you played the stock with the good news directly you might only catch the tail-end of 
the move, whereas by buying its correlated partners you could catch a much larger part of the 
move. 

You can trade dissimilar stocks off each other - if one has good news then you can go short on 
another, knowing that it should perform contrarily. 

You can balance your portfolio, making sure that you have a diverse set of items that will not be 
affected by each other.  In this case you select items that are not well-correlated with each other. 

 
TCScan+ works out correlation coefficients for the items you select compared to a reference item.  For  
example, you could choose the Nasdaq Composite index, COMPQX, and find which items in your list 
behave most similarly to it.  Correlation coefficients are a statistical measure that indicate how closely 
two curves move in the same way.  The correlation coefficient has a value between -1 and +1.  Values 
close to 1 show that the scanned item and reference item behave very similarly, while those close to -
1 behave in an opposite manner.  Values close to 0 indicate that the two items are not related at all.   
 
Note that correlation coefficients are not static - they change with time as the nature of the market and 
its participants change - you will need to update your correlations regularly.  Furthermore, stocks may 
be well-correlated on a short-term basis, but not long-term.  It is more probable that items that are 
well-correlated over a longer period of time will stay so, than they would if they only had a short-term 
correlation.  For this reason we recommend not basing judgments on correlations less than 100 
trading days. 
 
Another valuable feature of the correlation scan is that it enables you to build a map of the market, 
showing how stocks are related to each other in a graphical manner - you can then quickly see which 
stocks are best related to which, and how to balance your portfolio.  For example, below is a map of 
the correlation structure for the Dow Jones Industrial component stocks for the 500 trading days prior 
to 3/11/2005.  Stocks linked to each other are highly correlated, and those far apart from each other 
are much less well-correlated.  For this time period a well-balanced portfolio should have included 
stocks from the ends of the tree, for example, MRK, WMT, JNJ and IBM.  On the other hand, someone 
who was very bullish on Honewell (HON), and wanted to invest in similar movers could have also 
taken positions in AIG, MMM, BA or UTX. 
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You can use TCScan+ to construct trees such as this for your lists, but it would be very laborious, 
because it involves calculating correlation coefficients for every stock in the list, compared to every 
other stock.  You then have to find the best correlations, and construct a tree linking the best-
correlated stocks to each other.  Luckily, we have created a separate program, CorrelScan, to do this 
automatically, and it is available for free to registered users of TCScan+.  The program has many 
other features too, including easy trend detection and classification and can be downloaded from 
http://www.tcscanplus.com/Download.php. 

Correlation Scan Parameters 

 
Reference  You can select the reference item from the drop-down list, or you can type in any item 
name, if it is not in the list.  The reference does not need to be an index - it can be any item you 
are interested in. 

Positive  Checking this box will cause TCScan+ to search for positive correlations. 

Negative  Checking this box will cause TCScan+ to search for negative correlations. 

Detrend Data  Checking this box will cause TCScan+ to determine a simple moving average of 
the data, using the period you enter in 'Detrend Period'.  It will then subtract this average from the 
price to obtain a detrended price curve, i.e., one with the major trends removed. 

Shift Ref  This affects how TCScan+ will plot the reference item on the chart.  If this box is 
checked then the reference item will be plotted shifted over by the best offset found (if Max Offset 
is not zero).  If the box is not checked then the reference item will not be shifted on the plot and 
will appear the same for all items. 

Use Close  When this is checked, the correlation will be based on the close price rather than the 
average of the open, high, low and close. 

Min Correlation  The value in this textbox will be used to exclude less well-correlated items from 
the results.  The number is an absolute value so if you entered a value of 0.8 here, for example, 
then only positive correlations greater than or equal to 0.8 and negative correlations less than or 
equal to -0.8 will be shown in the results table. 

Smoothing  The value entered in this textbox will be used as the period for a simple moving 
average, which will then be used in place of the original data for the correlation calculations.   A 
value of '1' means that 1 bar will be used for each day's price, in other words, no smoothing will be 
applied.  A value of 2 will use 2-day averaging, etc. 

Detrend Period  The value entered in this textbox will be used as the period for the simple moving 
average used to detrend the price data.  We recommend values greater than 20. 

Max Offset is the maximum amount of offset to be allowed in the search for the best 
correlation.  The correlation coefficient will be calculated without an offset, and then the reference 
item data will be shifted forward by 1 day up to the maximum offset amount, one day at a 
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time.  For each offset, a correlation coefficient will be calculated and the best correlation and offset 
for this correlation will be shown in the results table.  This allows you to find items that are highly 
correlated with another, but separated by a time lag - you can then take a position in the lagging 
item days before it actually starts its move.  Note that items that show their best correlation right at 
the maximum offset, will probably show even better correlations at higher offsets.  You should be 
wary of accepting these correlations until you have increased the maximum offset even further, to 
find the true optimum offset. 

Log Scaling checking this box will cause TCScan+ to use Logarithmic Scaling (instead of the 
normal Arithmetic Scaling) for charts.  When using logarithmic scaling you will notice that the price 
axis numbers on the chart do not increase linearly, but rather proportionally.    

Typical Settings 

There aren't any specific guidelines for the Correlation scan parameters.  However, we suggest you 
use a Lookback Period of at least 100 trading days, and only consider correlations higher than around 
0.9 or lower than around -0.85.  We generally smooth the data by about 1/20th of the Lookback Period 
(e.g. 5 days smoothing for a Lookback Period of 100), and do not use the Detrend option.   

Results Table 

The table below summarizes the headings appearing in the results table (apart from PTrnd & VTrnd 
(the price and volume angle), Range (price range over the period of the scan) and the Back-Test 
statistics.)  With so many columns in the results table for this scan, it is advantageous to switch to 
Results-Only mode by pressing the F2 key. 
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Alpha & Beta versus Correlation Coefficient 

Correlation Coefficients are a statistical measure that indicate how closely two curves move in the 
same way.  The correlation coefficient has a value between -1 and +1.  Values close to 1 show that 
the item and reference item behave very similarly, while those close to -1 behave in an opposite 
manner.  Values close to 0 indicate that the two items are not related at all. 

Alpha, Beta, Standard Error and Risk Adjusted Return are all derived from a plot of the daily 
returns of the item versus the reference.  The daily return is the daily change in the item or reference 
and is calculated in two different ways depending on whether you have the 'Log Scaling' box checked 
on the Correlation tab: 

Arithmetic Return: Pi+1/Pi-1  

Logarithmic Return: Log(Pi+1/Pi) 

Where Pi+1 is the current day's price and Pi is the price a day earlier.  The price used is either the close 
or the average of the open, high, low and close, depending on whether you have checked the Use 
Close box. 

The daily returns of the item are plotted versus the reference and a best-fit straight line is drawn 
through them.  If the reference is an index, then a regular least square line (equivalent to Slope and 
Intercept functions in Microsoft Excel) is used but if the reference is not an index then a more 
advanced method is used that takes into account movement of both the reference and the current item.  
The alpha, beta, standard error and risk adjusted return are determined from the best-fit line as 
follows: 

  

As an example, the chart on the next page shows the daily returns of MRVL plotted against those of 
QQQQ.  By plotted against, we mean on a particular day the daily return of QQQQ is measured along 
the horizontal axis and then the daily return of MRVL is plotted vertically from there.  For example, 
consider the yellow-highlighted point near the top right of the chart.  This shows a day where MRVL 
increased by about 5.6% from the previous day, while QQQQ increased by around 2.6%.  This is done 
for all the days in your lookback period. 

You can see that, on average, MRVL has larger daily changes than QQQQ does.  This is illustrated by 
the slope of the line or Beta, which for the time period shown is 3.53.  This means that, on average, 
the daily return of MRVL is 3.53 times the daily return of QQQQ.  In contrast, Alpha is the Y intercept 
of the best-fit line, and estimates how much MRVL would change on a day when the QQQQ was flat 
(because it is the position of the best-fit line when the QQQQ return is  0.)  In other words, alpha is the 
excess return of MRVL over the QQQQ or, how much extra daily income you could expect by 
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investing in MRVL versus QQQQ.  In this case the alpha is 0.17%, which annualizes to 41.9% (as 
would be shown in the results table.) 

 

One more item is needed, however, to make a better investment decision.  Consider the two returns 
plots below for MWE and IWP versus QQQQ.  Both stocks provide a similar alpha over this time frame 
and MWE has a higher Beta, so tends to change in larger increments than IWP.  However, looking at 
the left chart, you see that the points are a lot more scattered around the line than on the right 
chart.  The scatter means that there is a lower chance that MWE will provide returns consistent with 
the best-fit line than IWP will.  This is reflected in the standard error numbers: MWE's is 12.5% and 
IWP's is 3.8% and shows that MWE would be a more risky investment than IWP.  Instead of looking at 
alpha, therefore, it is better to look at the risk adjusted return, which is alpha adjusted for the standard 
error.  In this case, you can see that IWP offers a risk adjusted return of 1.6 versus 0.5 for MWE. 
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 Correlation Scan Examples 

Following are some examples of Correlation scans with different time periods.  The vertical dotted line 
shows the day of the scan, the data following it shows how the linkage continued after the scan 
date.  Note the correlation coefficient values printed at the bottom of the charts, followed by the offset.

  
The first two charts show two stocks highly-correlated with NXTL - note how their behavior is similar 
after the scan date. 

 

 
The next two charts show stocks that are anti-correlated with NXTL - note how they keep moving in 
opposite direction to NXTL after the scan date. 
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The next two charts show Indices highly correlated with the Nasdaq Composite, COMPQX.  You can 
run the same scan with stocks. 

 

 
Here is a good example of long-term anti-correlation in indices: The 30-Year Bond index (TYX--X) 
versus the Utility Index (UTY--X) over a period of almost six years.  Note the offset by four days, but 
over a long period such as this we would not consider this amount of offset to be significant. 
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The last three charts show stocks highly correlated with the Small Cap Russell 2000 Index (RUT-X).
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Volatility Stop Scan 

Numerous studies have shown that the key to successful trading is having a reliable exit method - one 
that protects against major losses, and also protects profits that have been accumulated.  It has been 
shown that even with a random entry, it is possible to make money with a good exit method - but the 
reverse is not true - you can have the best entry system in the world, but if you use random exits you 
will not make money over time.  The Market Wizard, Van K. Tharp says in his must-read book "Trade 
Your Way to Financial Freedom" that at least as much time should be spent on the exit method as on 
the entry method.  Yet most investors and traders spend 90% of their time looking for the right time to 
buy - largely ignoring when they will get out.  No wonder so many traders lose money! 

There are a wide variety of stop methods, but many successful traders have found volatility stops to be 
one of the most useful.  Van Tharp, for example, says "My experience is that volatility stops are 
among the best stops you could select."  These stops are dynamic in nature, that is, they trail price 
and adjust themselves to the way the market is moving at that moment.  If the market is very volatile, 
they give the stock more room to move so that you don't get stopped out unnecessarily, and when the 
market is quieter they become tighter.   

Volatility Stop Principle 

A stop for a long position is calculated by first looking back on the chart to find a recent 
high.  TCScan+ then adds a multiple of the average true range to a multiple of the standard deviation 
of the average true range, and subtracts this sum from the most recent high.  A short position stop is 
calculating by adding the multiples to a recent low.  Changes in trend usually occur after periods of low 
volatility, so it is generally better that stops are tightened then. 

Definitions 

True Range (TR) is the difference between the highest of the bar's high and the previous bar's close 
subtracted from the lowest of the bars's low and the previous bar's close.  The True Range is used in 
preference to the bar's range (high-low) because the TR takes into account gaps in price.  The 
diagrams below make the definition of TR clearer. 

           

  

Average True Range (ATR) is the simple moving average of the True Range. 

Standard Deviation of the True Range is a measure of how the True Range varies with 
time.  Standard deviation is a standard statistical measure of the variability of a variable.  It is useful to 
include this measure in the calculation of the stop, because although the ATR changes with time and 
therefore adjusts to the item's volatility, it is not as sensitive a measure of the variance of volatility as is 
the standard deviation. 
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Volatility Stop Scan Parameters 

The Stop Tab allows you to set the parameters for the volatility stop scan.  As with previous scan 
types, set up a test list in TeleChart, change the parameters on the Tab and see how they affect the 
stop calculation.  Also, you can choose a particular stock you are interested in and run the scan just 
for it (Ctrl-F9) using different values for the settings.  This will help you to see how the parameters 
would have affected the stops in the past, and give you and indication of how you should set your 
stops in the future. 

 

The parameter descriptions below are written for long position stops, but are equally applicable to 
short position stops. 

Highest High Lookback specifies how far back TCScan+ should look for a recent high or low.  A 
higher number is better for longer-term positions, while a lower number allows more responsive 
stops and is better for shorter-term positions. 

ATR/Std Dev Period specifies how many bars to use in working out the Average True Range 
(ATR) and standard deviation (Std Dev) of the True Range.  This parameter allows you to specify 
how responsive the stop should be to recent volatility.  If you specify a long period, then the stop 
will be more stable and less responsive to recent stock movements.  A short period will produce a 
stop that is much more responsive to recent moves - your choice will depend on your trading time 
frame. 

No. Average True Ranges is the number of Average True Ranges to subtract from the recent 
high. 

No. Standard Deviations is the number of Standard Deviations of the Average True Range to 
subtract from the recent high. 

Limit to Trend  Checking this box will tell TCScan+ to only show stops appropriate to the trend, 
i.e., it will only display long stops when the trend is up, and short stops when the trend is 
down.  When this box is checked, then the box below it, Short Term, becomes 
enabled.  Checking this box will get TCScan+ to consider shorter-term trends in deciding whether 
to show stops or not, while leaving it unchecked will get TCScan+ to consider longer-term trends 
for the display. 

Include +2 STDs  Checking this box means that, in addition to the stop you select, TCScan+ will 
determine two additional stops that are one and two standard deviations beyond your selected 
stop.  We like to check this option, using the three stops as traffic signals.  A cross through the first 
line is a warning, a cross through the second is an exit signal, and a cross through the third is 
'Abandon all hope, and get out now!'. 

Force Up  Checking this box means that the stop will not be allowed to move down over the 
period of the HHV/LLV Lookback period.  It is common for the stop to move down as the volatility 
increases, but you might prefer this not to happen. 
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Dot Style  Check this to have the stops shown as dots on the chart, instead of lines. 

Log Scaling  Checking this box will cause TCScan+ to use Logarithmic Scaling (instead of the 
normal Arithmetic Scaling) for charts.  When using logarithmic scaling you will notice that the price 
axis numbers on the chart do not increase linearly, but rather proportionally.    

Typical Settings 

The picture of the Stop Tab above shows our preferred stop parameter settings for short-term (days to 
weeks) trades.  For longer-term (months) trades we suggest increasing the periods to 20, and the 
Number Std Devs to 3 or 4 or higher - however we also suggest tightening the stops for these 
positions, by reducing the Number Std Devs, if the stock is becoming overextended (as indicated by 
long-term RSI, Stochastics, or Fibonacci extensions).  Note that we typically adjust the Number Std 
Devs but leave the Number ATRs at 1, because the standard deviation is a more sensitive measure of 
variation in volatility.  However for longer-term trades you may choose to increase the number ATRs 
too.   

Results Table 

The column headed 'Name' lists the names of the items that passed your filter criteria.  The column 
headed 'Stop' is the stop position for the next day of trading.  If you have selected the Include +2 STDs 
option then two additional stops, one and two standard deviations beyond the selected stop will also 
be displayed.  'Pos' indicates whether at the time of the scan, the price is above (In) or below (Out) the 
stop.  'Pos+1' and 'Pos+2' indicate the same for the extra STD stops if you have included them in your 
scan.  PTrnd and VTrnd show the price and volume trend slopes respectively.   'Range' is the price 
range (highest high - lowest low) over the period of the scan.  
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Volatility Stop Scan Examples 

Following are some examples of Volatility Stop scans with different time periods and degrees of Stop 
Tightness. 

Long Position Stops 
  

 

Shown below is a close up of the latter part of the chart above, to 
illustrate the 3-tier stop system. 
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The next three charts show how it is sometimes advantageous to tighten your stops when the price 
becomes overextended.  The first chart shows a long-term stop in place. 
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The next chart includes Fibonacci levels and shows that the price is already overextended at the 
position of the Blue Ellipse.  At that point it would be prudent to tighten your stops. 

 
The next chart shows an enlargement of the period from 2/2000 to 5/2000, but with a tighter stop.  As you 
can see, we preserve a greater amount of profit by tightening our stops when our technical analysis tells us 
to do so. 
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 Short Position Stops 
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TCScan+ 2.6.7 Help File 

84 

Pattern Scan 

The Pattern Scan helps you identify traditional Japanese CandleStick patterns as well as a variety of 
other western patterns.  Many patterns have been built into TCScan+ (see links above) and you can 
also define your own patterns using the same PCF language found in TeleChart.  
 
Candlestick patterns were originally developed in Japan in the 18th and 19th centuries for rice futures 
trading.  They have since become widespread throughout the world, in all forms of trading.  They 
consist of groupings of bars in particular arrangements that have proven to be highly probable 
indicators of future movement.  Many books are available to provide more details on Candlestick 
patterns.  Our favorite is Candlestick Charting Explained by Gregory L. Morris.  Another good one is 
Profitable CandleStick Trading by Stephen Bigalow. 
  
Candlestick Bars 
When you understand their construction, candlestick bars are easier to read than the traditional 
western bars and convey more information.  The open to close price range forms a body that is 
colored white if it was an up day and black if it was a down day.  Lines are then drawn from the top of 
the body to the high, and from the bottom of the body to the low.  These lines are almost like the wicks 
of a candle, with the body forming the candle itself and that is where this bar type get its 
name.  Shown below are pictures of white (up close) and black (down close) candlesticks and their 
equivalent western versions.  

 

Candlestick Patterns 
Hundreds of candlestick patterns are available, and trying to search and understand them all can be 
quite confusing and unproductive.  TCScan+ includes only the more reliable ones, and provides the 
ability for you to add any other patterns you choose.   
 

Pattern Tab 

The Pattern Tab allows you to select which of the patterns to include in your 
scan.  The Pattern Tab allows you to select which of the patterns to include in your scan.  You can 
individually check or uncheck patterns in the list, click the 'Find' button to find patterns in the list, or 
press the 'Select' button to select or deselect groups of patterns at a time.  Right-clicking within the list 
will bring up a menu allowing quick access to the Find and Select commands.  It will also allow you to 
open up Help for the currently highlighted pattern as well as to display a list of all the selected items in 
the list. 
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TCScan+ provides two different modes for pattern scanning.  They use respectively: 

1. Built-In Patterns that have been hard-coded into the TCScan+ program and can not be 
changed, deleted or added to, and 

2. Editable Patterns that can be created and edited using the same language used in TeleChart 
to create PCF formulae.  These Patterns can be edited, changed, deleted, and 
renamed.  Furthermore, in this mode, you can add your own patterns as well. 

The advantage of the Editable Patterns is that you can modify or add to them but their disadvantage is 
that the patterns have to be recompiled by TCScan+ each time they are run.  As a result, scanning 
with these patterns is relatively slow, particularly when showing a chart with historical patterns shown 
on it.  (When such a chart is shown, the program must check every day on the chart and run through 
all the patterns for that day to see if a pattern was in place.)  The calculation speed is the reason why 
the Built-In Pattern option was included and set as the default.  The Built-In patterns are written into 
the program itself, so calculations and chart display are much quicker.  One option would be to use the 
Editable Patterns only for the patterns you add, while using the built-in patterns for the other 
scans.  You can do this by using the checkboxes in the pattern selection list or clicking the Select 
button. 

You can switch between the two modes by checking or unchecking the checkbox labeled Editable 
Patterns.  When the Editable Patterns box is checked, you will see that the Edit button on the pattern 
tab becomes enabled, allowing you to edit, rename, test and delete your patterns.   

The checkboxes at the bottom of the pattern tab allow you to specify whether past patterns should be 
highlighted on the chart, and whether pattern names should be displayed.  The 'past pattern' setting is 
important to take note of if you are using the Editable Pattern setting described above.  In this case, 
TCScan will scan all the data in your chart, displaying where past patterns appeared.  If you have a lot 
of data, the calculation can take a long time and slow display of the chart.  

Scanning for Patterns 
The procedure for finding patterns is very simple.  All you need to do is select the patterns you wish to 
find then press the 'Start Scan' button.  When running the Pattern Scan, you have the option of having 
symbols appear on your charts to indicate where a pattern has been found. You also have the option 
of displaying where patterns occurred in the past on your charts.  As explained previously, this option 
requires a lot of processing power, particularly if you have a long lookback period, so can cause charts 
to appear quite slowly.  Your options to speed up the chart display are to select fewer patterns to scan, 
switch from Editable Patterns to Built-In ones, and to reduce your lookback period. 
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Editing Patterns 

The Editable Pattern definition files are stored individually in the Patterns folder of your TCScan+ 
directory (usually C:\Program Files\TCScan+\Patterns.)  You can share any pattern files you create 
with other TCScan+ users by sending them the appropriate file and having them save it to their 
Patterns folder.  When you delete any patterns (see below) TCScan+ will actually delete the 
corresponding file in this directory.  Therefore be sure to make regular backups of your Patterns folder 
to prevent accidental loss. 

When the checkbox on the Pattern Scan Tab marked 'Editable Patterns' is checked, you change to 
Editable Pattern mode, and the 'Edit' button becomes enabled.  Clicking on the 'Edit' button brings up 
the Pattern Editing Form. 

 

This form allows you to: 

Move between patterns - by selecting them from the drop-down list, or using the navigation 
arrows just above the drop-down list.  

Rename patterns or their abbreviation codes, by clicking on the 'Rename' button just above the 
drop-down box.  

Delete patterns, by clicking the 'Delete' button just above the drop-down box.  

Rate the patterns as Bullish, Bearish, Bullish Continuation, Bearish Continuation, or Not Rated - 
by clicking the appropriate option button in the Rating section.  

Edit the formula,  by typing a formula into the Formula box.  The formulae are entered using the 
same language used in TeleChart to create PCF formulae.  All price-based variables available in 
TeleChart can be entered here, as well as two extra variables: 'B' for the size of the body (Abs(O-
C)), and 'R' for the high to low range.  It also provides codes to use for candlestick building blocks, 
such as 'DOJ' for a Doji, 'BM' for a Black Marubozu, 'LWC' for a long white candle, etc.  You can 
click on the button marked 'Formula Builder' just above the Formula box to get assistance in 
creating the formulae.  The Formula Builder form also allows you to change the formulae for the 
candlestick building blocks.  
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Add Comments,  by typing text into the comments box.  

Specify the current trend in Price and Volume, by checking the Price Trend and/or Volume 
Trend checkboxes then setting the number of bars over which to work out the trend.  The 
minimum and maximum trend angles can be specified by entering the values, moving the arrows 
in the picture box, or clicking the up/down angles. 
 

 
 
Test the Patterns by entering a symbol to test and then pressing the 'Test' button.  The testing 
lookback period, shift and time frame will match that used on the main TCScan+ form to help you 
debug/create patterns that you see while doing other scans.  

View the Patterns by pressing either the 'View Random' or 'View Actual' buttons.  The 'View 
Random' button causes TCScan+ to generate random price data that it tests in the formula until it 
finds a match to the pattern you have entered.  Once found, the data is shown in the picture box 
above the button.  The 'View Actual' button will load data from TeleChart for all the stocks over 
approximately the last 100 days of trading.  It will test every stock on every day until it finds a 
match to the pattern, which it then displays on the chart.  The chart will also show the stock name 
and the date the pattern was found.  Both of these View methods can take a long time to show 
results if you have a complicated or very restrictive pattern.  We suggest starting with the 'View 
Random' button and if nothing appears for a few minutes, then trying the 'View Actual' 
button.  Once clicked, you can click the button again to stop the search.  

Include the Pattern in your scan by checking the box at the bottom of the form.  

Create New Patterns by pressing the 'NEW' button at the bottom of the form.  

Save your changes by pressing the 'SAVE' button at the bottom of the form.  
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Bearish Patterns 

Abandoned Baby in Uptrend 

 

  

In an uptrend, a white candle is followed by a Doji that gaps above it completely. 
The next day is a black candle that gaps completely below the Doji.  
   
Confirmation: Not Required   

Bearish Engulfing 

 

  

  
In an uptrend, a small white candle with low volume is followed by a much higher 
volume black candle that engulfs the body of the previous white candle.   
   
Confirmation: Required (See Three Outside Down)  
  

Bearish Harami 

 

  

  
In an uptrend, a long white candle with above average volume is followed by a black 
candle that gaps down, closing within the body of the first day. Volume for the black 
candle is lower than for the white candle.  
   
Confirmation: Required (See Three Inside Down)  
  

Breakdown 

 

This is an example of a breakdown pattern, similar to the Breakout one, that is included to show that 
not only traditional candlestick patterns can be searched for.  It scans items that have been trading 
relatively flat for the previous 20 bars and then have an above-average-length black bar that closes 
near its low and whose low is lower than the lowest low of the previous 20 bars. 
  
Confirmation: Not Required   
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Counter Punch Short 

 

This is a contrarian pattern described by Thomas Stridsman in his book 'Trading Systems and Money 
Management' that is shown by him to be very profitable.  He also includes additional rules on position sizing 
and stop loss methods.  The pattern has been modified from his version to include confirmation, i.e., the 
current bar must close down and also close lower than the previous day's close.  The pattern basically looks 
for stocks that have been trending too long and so are ready for a pullback.  The pattern Stridsman 
describes can be formulated as 'C>C1 AND C1>C2 AND C>C5 AND C5>C10', which we have modified to 
'C1>C2 AND C2>C3 AND C1>C6 AND C6>C11 AND BC AND C<C1' for confirmation. 
  
Confirmation: Not Required   
  

Dark Cloud Cover 

 

  

  
In an uptrend, a long white candle is followed by a a black candle that opens above the high 
of the prior day and closes below the midpoint of that day.  
   
Confirmation: Not Required   
  

Dave Paxton Bearish Star Confirmation 

 

  

  
An example of a user-defined scan from Dave Paxton of Y2Kseminars.com.  It's purpose 
is to confirm a Bearish (Evening) Star and looks for either of two sequences: 
 
(a) A white candle is followed by a bar that gaps above it, closes at or above the previous 
close and has a high that is the highest of the last 5 bars. This bar is followed by a black 
candle that closes below the open of the starting white bar. 
 
(b) A white candle is followed by a bar that gaps above it and closes at or above the 
previous close. This bar is followed by a black candle that opens at or below the previous 
close. The next (last) bar closes below the open of the original white bar. 
   
Confirmation: Not Required   
  

Evening Doji Star 

 

  

  
In an uptrend, a long white candle is followed by a Doji that gaps up. This is 
followed by a black candle that opens below the Doji.  
  
Confirmation: Not Required   
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Evening Star 

 

  

  
In an uptrend, a long white candle is followed by a day that gaps above it. This is 
followed by a black candle that gaps below the day before it and closes below the 
close of the first day.  
  
Confirmation: Not Required   
  

Falling Three Methods 

 

  

  
In a downtrend, a long black candle is followed by three white candles that 
open and close successively higher, but not higher than the open of the 
first long black candle. The last day is a black candle that closes below the 
close of the first black candle.  
  
Confirmation: Not Required   
  

Gary Smith Short 

 

This is a breakdown pattern described by Gary Smith of TheStreet.Com in Technical Analysis of 
Stocks & Commodities Magazine, October 2000. It is included as an example of a non-traditional 
candlestick pattern. 
 
It scans only items with a current price greater than 20 and an average daily volume greater than 
500,000. It then finds items whose current close is lower than the lowest close of the previous 5 bars 
and is also at least one point lower than the previous day's close. Finally, the breakdown day's volume 
must be at least 50% greater than the average daily volume over the previous 50 bars. 
  
Confirmation: Not Required   
  

Hanging Man 

 

  

  
In an uptrend, a small body appears near the top of its daily range. The lower shadow 
should be at least twice as long as the body.  
  
Confirmation: Required   
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Identical Three Crows 

 

  

After an uptrend, three similar black lines open and close successively lower. The 
second day opens near the close of the first and the third day opens near the 
close of the second.  
  
Confirmation: Not Required   

Kicking Bearish 

 

  
A black marubozu gaps under a white marubozu. The prior trend is not important.  
  
Confirmation: Not Required   

Lowest Low 

 

Lowest-Low patterns are included for 25, 50 and 100 day lookback periods.  In editable pattern mode 
you can define alternate lookback periods. These patterns are most useful as prescans, to filter your 
list down to the more-promising ones before running other scans on them. 
  

Meeting Lines in Uptrend 

 

  

In an uptrend, a long white candle is followed by a long black candle that closes near 
the close of the previous day.  
  
Confirmation: Suggested   
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Tasuki Gap in Uptrend 

 

  

  
In an uptrend, a white candle gaps over a white candle. The next day opens down 
within the body of the previous white candle and closes a part, but not all, of the gap 
between the first and second bars.  
   
Confirmation: Recommended - NB This pattern is normally rated Bullish 
Continuation, but tends to be Bearish for a few bars.  
  

Three Black Crows 

 

  
After an uptrend, three similar black lines open and close successively lower.  
  
Confirmation: Not Required   

Three Inside Down 

 

  

  
In an uptrend, a long white candle with above average volume is followed by a small 
black candle of lower volume that is engulfed by the previous day. The third day is 
also a black candle that closes lower than the first day, confirming the trend.  
  
Confirmation: Not Required   
  

Three Outside Down 

 

  

  
In an uptrend, a small white candle with low volume is followed by a much higher 
volume black candle that engulfs the body of the previous white candle. This is 
followed by another black candle that closes below the close of the prior black 
candle.  
  
Confirmation: Not Required   
  

Upside Gap Two Crows 

 

  

In an uptrend, a long white candle is followed by a black candle that gaps up. This 
is followed by another black candle that engulfs the previous, but still closes above 
the close of the first white candle.  
   
Confirmation: Suggested   
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 Bullish Patterns 

Abandoned Baby in Downtrend 

 

  

  
In a downtrend, a black candle is followed by a Doji that gaps below it completely. 
The next day is a white candle that gaps completely above the Doji.  
   
Confirmation: Not Required   
  

Breakout (Up) 

 

This is an example of a breakout pattern, included to show that not only traditional candlestick patterns 
can be searched for.  It scans items that have been trading relatively flat for the previous 20 bars and 
then have an above-average-length white bar that closes near its high and whose high is higher than 
the highest high of the previous 20 bars.  It also must have an increasing volume over the last 3 bars. 
  
Confirmation: Not Required   
  

Bullish Engulfing 

 

  

  
In a downtrend, a black candle is followed by a white candle that engulfs the body of 
the first black candle.  
  
Confirmation: Required (See Three Outside Up)   
  

Bullish Harami 

 

  

  
In a downtrend, a long black candle with average volume is followed by a white candle 
that gaps open and closes within the body of the first day. The white candle has higher 
volume than the first day.  
  
Confirmation: Required (See Three Inside Up)   
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Concealing Baby Swallow 

 

  

   
In a downtrend, two black Marubozu candles are followed by a black candle 
that gaps down, but trades into the body of the second Marubozu. The last day 
is also black and engulfs the previous day completely.  
   
Confirmation: Not Required   
  

Counter Punch Long 

 

This is a contrarian pattern described by Thomas Stridsman in his book 'Trading Systems and Money 
Management' that is shown by him to be very profitable.  He also includes additional rules on position 
sizing and stop loss methods.  The pattern has been modified from his version to include confirmation, 
i.e., the current bar must close up and also close higher than the previous day's close.  The pattern 
basically looks for stocks that have been trending too long and so are ready for a pullback.  The 
pattern Stridsman describes can be formulated as 'C<C1 AND C1<C2 AND C<C5 AND C5<C10', 
which we have modified to 'C1<C2 AND C2<C3 AND C1<C6 AND C6<C11 AND WC AND C>C1' for 
confirmation. 
  
Confirmation: Not Required   
  

Dave Paxton Bullish Star Confirmation 

 

  

   
An example of a user-defined scan from Dave Paxton of Y2Kseminars.com.  It's 
purpose is to confirm a Bullish (Morning) Star and looks for either of two sequences:
 
(a) A black candle is followed by a bar that gaps below it, closes at or below the 
previous close and has a low that is the lowest of the last 5 bars. This bar is 
followed by a white candle that closes above the open of the starting black bar. 
 
(b) A black candle is followed by a bar that gaps below it, closes at or below the 
previous close and has the lowest low of the past 5 bars. This bar is followed by a 
white candle that opens at or above the previous close. The next (last) bar is also 
white and closes above the open of the original black bar.  
   
Confirmation: Not Required   
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Gary Smith Long 

 

This is a breakout pattern described by Gary Smith of TheStreet.Com in Technical Analysis of Stocks 
& Commodities Magazine, October 2000. It is included as an example of a non-traditional candlestick 
pattern. 
 
It scans only items with a current price greater than 20 and an average daily volume greater than 
500,000. It then finds items whose current close is higher than the highest close of the previous 5 bars 
and is also at least one point higher than the previous day's close. Finally the breakout day's volume 
must be at least 50% greater than the average daily volume over the previous 50 bars. 
  
Confirmation: Not Required   
  

Highest High 

 

Highest-high patterns are included for 25, 50 and 100 day lookback periods.  In editable pattern mode 
you can define alternate lookback periods. These patterns are most useful as prescans, to filter your 
list down to the more-promising ones before running other scans on them. 
  

Hammer 

 

  

  
In a downtrend, a small body appears near the top of its daily range. Lower shadow 
should be at least twice as long as the body.  
  
Confirmation: Required   
  

Inverted Hammer 

 

  

  
In a downtrend, a black candle is followed by a candle with a small body near the 
bottom of its range.  
  
Confirmation: Required   
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Kicking Bullish 

 

  

A white marubozu gaps over a black marubozu. The prior trend is not important.  
  
Confirmation: Not Required   
  

Mat Hold 

 

  

  
In an uptrend, a long white candle is followed by a black candle that gaps 
above it. This is followed by two black candles that close successively 
lower than the first black candle, but do not fall lower than the open of the 
first long white candle. The last day is a white candle that gaps up and 
closes above the three black candles preceding it.  
  
Confirmation: Not Required   
  

Meeting Lines Downtrend 

 

  

In a downtrend, a long black candle is followed by a long white candle that closes 
near the close of the previous day.  
  
Confirmation: Suggested   
  

Morning Doji Star 

 

  

  
In a downtrend, a long black candle is followed by a Doji that gaps down. This is 
followed by a white candle that opens above the Doji.  
  
Confirmation: Not Required   
  

Morning Star 

 

  

  
In a downtrend,  a long black candle is followed by a day that gaps below it. This is 
followed by a white candle that gaps above the day before it and closes above the 
close of the first day.  
  
Confirmation: Not Required   
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Rising Three Methods 

 

  

  
In an uptrend, a long white candle is followed by three black candles that 
open and close successively lower, but not lower than the open of the first 
long white candle. The last day is a white candle that closes above the 
close of the first white candle.  
  
Confirmation: Not Required   
  

Side by Side White Lines 

 

  

In an uptrend, two white candles are side by side after gapping above another white 
candle. The last two candles should be about the same size and open close to each 
other.  
  
Confirmation: Not Required   
  

Tasuki Gap in Downtrend 

 

  

  
In a downtrend, a black candle gaps under a black candle. The next day opens up 
within the body of the previous black candle and closes a part, but not all, of the gap 
between the first and second bars.  
   
Confirmation: Recommended - NB This pattern is normally rated as Bearish 
Continuation, but tends to be Bullish for a few bars.  
  

Three Inside Up 

 

  

  
In a downtrend, a long black candle with average volume is followed a white candle 
that gaps open and closes within the body of the first day. The white candle has 
higher volume than the first. The third day is a white candle that closes above the 
first, confirming the move.  
  
Confirmation: Not Required   
  

Three Outside Up 

 

  

  
In a downtrend, a black candle is followed by a white candle that engulfs the body of 
the first black candle. This is followed by another white candle that closes above the 
prior white candle.  
  
Confirmation: Not Required   
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Three White Soldiers 

 

  
After a downtrend, three similar white lines open and close successively higher.  
  
Confirmation: Not Required   

Unique Three River Bottom 

 

  

  
In a downtrend, a long black candle is followed by a black Harami that opens 
above the close of the previous day, but trades lower than the previous day. The 
next day is a small white candle that opens and closes below the body of the 
previous day.  
  
Confirmation: Suggested   
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Pattern Formula Builder 

The Formula Builder helps you to build your pattern formulae by selecting items from drop-down 
lists.  The formulae can consist of price data (e.g. O,H,L,C,V), mathematical functions (e.g. ABS, AND, 
OR) and also primal or basic candle patterns.  For example, if you select 'Black Opening Marubozu' in 
the drop-down list in the middle-left of the form then select '3 Bars back' from the drop-down list next to 
it and then press the ENTER button, the pattern abbreviation 'BOM3' will be added to the formula box 
on the Pattern Edit form. (See the picture below.) 

 

You can also select functions such as Absolute Value, Minimum and Maximum from the functions 
drop-down list at the bottom of the form then press the button just to the right of the drop-down list to 
have the formula for the function entered. 

Likewise, you can enter price patterns from the 'Price' section at the top of the form.  For example, if 
you wanted to know the formula for the largest body size for the 5 bars up to yesterday, then you 
would select the following in the 'Price' section followed by clicking the ENTER button. 
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Basic Candle Pattern Summary 

A summary of the basic candle patterns included in TCScan+ is listed below.  You can edit/view these 
basic patterns formulae by clicking the EDIT button in the middle-right of the Formula Builder form. 

Name    Code   Picture Description

Black Candle    BC    A down-close bar, i.e., any bar that closes lower 
than it opens. 

Black Closing Marubozu    BCM    

A down-close bar where the close is at the low, 
i.e., there is no wick on the bottom.  This is a 
strong indication of continued bearishness in a 
downtrend. 

Black Marubozu    BM    

A down-close bar where the open is at the high 
and the close is at the low, i.e., there are no 
wicks on the candle.  This is generally an 
indication of bearish continuation. 

Black Opening Marubozu   BOM    

A down-close bar where the open is at the high, 
i.e., there is no wick at the top.   This is an 
indication of continued bearishness in a 
downtrend, but is not as strong a signal as a 
closing marubozu. 

Doji    DOJ    

A bar where the open and the close are equal. 
Dojis are a stronger form of the spinning top, 
indicating a strong contest between bulls and 
bears.  They should be watched as a sign of 
reversal during a trend, especially in an uptrend.

Dragonfly Doji DDOJ A Doji where the open and close are at the high 
of the bar. 

Four Price Doji FDOJ A flat bar, i.e., the open, high, low and close are 
equal or very close to each other. 
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Name    Code   Picture Description

Gravestone Doji GDOJ A Doji where the open and close are at the 
bottom of the bar (inverse of the Dragonfly Doji.)

Long Black Candle LBC A down-close bar whose body is significantly 
larger than average. 

Long White Candle LWC An up-close bar whose body is significantly 
larger than average. 

Long-Legged Doji LLD A Doji that has longer than average upper and 
lower wicks. 

Short Black Candle SBC A down-close bar that has a shorter body than 
average. 

Short White Candle SWC An up-close bar that has a shorter body than 
average. 

Spinning Top ST 

A bar that has a much shorter body than the 
range.  This is an indication of indecision in the 
market and is considered neutral in a sideways 
market.  In a trending market, however, the next 
day should be watched as an indication of the 
future trend. 

White Candle WC A bar where the close is higher than the open. 

 



TCScan+ 2.6.7 Help File 

102 

 

Name    Code   Picture Description

White Closing Marubozu WCM 
An up-close bar where the close is at the 
high.  This is a strong indication of continued 
bullishness in and uptrend. 

White Marubozu WM 
An up-close bar where the open is at the low 
and the close is at the high.  This is generally an 
indication of bullish continuation. 

White Opening Marubozu WOM 

An up-close bar where the open is at the 
low.  This is an indication of continued 
bullishness in an uptrend, but is not as string a 
signal as a closing marubozu. 
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Pattern Scan Examples 

Shown below are some examples of Pattern scan charts.  The red arrows show Bearish patterns 
found and the blue arrows show Bullish patterns. 
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Support and Resistance Level Scan 

The Support and Resistance Level scan allows you to find horizontal support and resistance levels, 
where upward price movement is hindered (resistance) or downward price movement is prevented 
(support.)  In addition to the well-known price-based support and resistance levels, TCScan+ also 
allows you to find volume-based levels. 
 
Price-based support and resistance levels are found by searching through the stock data and locating 
all the points where price has changed trend previously.  These pivot points become high-probability 
locations where price will turn again.  TCScan+ sums the number of past pivot points and displays the 
count at each price level in the form of horizontal bars on the right of the chart - an example is shown 
below.  The wider (left-right) the bar, the more past turning points there have been within the range of 
that bar.  Generally the more turning points at a certain location, the more likely that price will turn 
there again.  However, there is an opposing principal that the more a level is "tested" the weaker it 
gets - therefore it is prudent to have well-placed stops no matter how sure you are of a level.  We have 
also seen time and again where only one previous turning point has meant enough to cause price to 
turn there again. 
 
In the chart for BBOX below, you can clearly see the strong support around 40 for this stock, along 
with less-significant levels.  In the two months following this scan date, the stock climbed up to around 
57 again. 
  

 
  
Volume-based support and resistance levels are found by summing the daily volume at each price 
level to create a cumulative curve of past volume activity at each price.  You can therefore see at what 
price levels there has been a lot of trading activity.  As with the price level boxes, this curve is plotted 
on the right of the chart in TCScan+.  The chart below is the same as the one above, but now includes 
the cumulative volume curve in blue. (The price boxes have been colored lighter to make the volume 
curve easier to see.)  The peaks of the curve show where there has been a lot of past volume activity 
at that price level.  For example on the chart below, you can see a lot of volume activity occurred at 
prices around 42, 52 and 55.  
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Unlike price-based pivot points, volume activity occurs at virtually every price level, so you do not get 
the nice square support boxes that you get with the price levels.  Therefore, to help differentiate the 
peaks from other activity, TCScan+ also works out a moving average of the volume curve.  Wherever 
the peak extends to the left of the moving average, volume activity has been above average.  The 
chart below shows the moving average in red plotted in addition to the volume curve in blue.  You can 
get TCScan+ to alert you whenever price is close to one of these above-average peaks.  Our studies 
have shown that volume peaks are good anticipators of price turning points.  The most likely 
explanation is that the bulls and bears fight it out at certain points (high volume), then one group wins 
and you get a push in one or the other direction.  At this point, price is overextended and you get a 
turning point.  
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Parameter Description 

The picture below shows the Support and Resistance Scan tab, with default settings. Settings that 
apply to the Price-based levels only are shown in blue, and those for volume-based levels are shown 
in green.  There are no specific Volume-based settings on the main tab, but there are some options on 
the advanced options page (described below.)  Settings that apply to both price and volume-based 
levels are shown in black. 
  

 
  

Price Levels / Volume Levels  checking these boxes will search for proximity near price or 
volume-based levels respectively.  Note that both level types are always generated - checking 
these boxes only indicates whether TCScan+ should alert you when price is near one or both of 
them.  You can select whether to display either type on the Advanced Options form. 

Price Up / Price Down  these boxes indicate whether to include items whose price is trending up 
or down since the last pivot point.  The names of these settings are also shown as 
Support/Resistance when using the Last price level setting.  The length of the trend is set by the 
price distance between pivot points, which is adjusted via the % Retracement for determining 
pivots setting on the Advanced Options form. 

Pivots to use: Upper / Lower  are used to tell TCScan+ whether to use either one or both of the 
upper or lower pivot points in looking for the price-based levels. 

Level to Check  this option sets whether the program will test for proximity, number touches, 
breaking, etc. at the price level of the last pivot point or at the one closest to the current price.  If 
you are interested in looking for bounces off a level, you would probably use the Last option, 
whereas if you are looking for level breaks or proximity to a level, you would use the Closest 
option.  When you select the Last option, the titles of the Price Up/Price Down checkboxes will 
change to Support/Resistance respectively.  This is because when considering the level at the last 
pivot point, price moving up from there indicates that the level was a support, otherwise it was a 
resistance. 

Maximum bars since last pivot specifies the most number of bars that can have elapsed since 
the last price pivot point.  This setting is useful in conjunction with the Last level to check setting 
above when trying to find a recent bounce off a price level.  An example scan settings file called 
'Bullish - SR - Bounce off price support' uses these settings to find a bounce off a recent price 
support.  You can load it via the File > Load Scan Settings command.  If you want to ignore this 
setting, leave the box empty. 

Minimum Touches is the minimum number of previous touches that must have been made to the 
price level. 

Broken/Unbroken Allows you to specify whether the price or volume level in question has been 
broken or unbroken since the specified number of bars back. 

Alert Proximity% specifies how close the current price must come to the price and/or volume 
level, in percent, for you to be alerted of that fact.  If you want to ignore this setting then leave the 
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box empty. 

Advanced Options  Clicking this button will open the Advanced Options form, as shown 
below.  Most of the settings should be clear from the description, but you can click on the picture 
(in the actual help file) to get further information. 

 

 

  
Typical Settings 

The settings shown on the tab the first time you use it are a good start to using this scan type, but it 
will find a whole range of broken and unbroken levels, as well as ones where price has bounced off a 
level.  Use the various settings available to fine tune the scan to exactly what you want.  You can also 
review the example scan settings files ( File > Load Scan Settings) for clues on how to achieve the 
desired effects.  For the price level scan, you can try adjusting the minimum number of touches and 
the retracement% (on the advanced tab).  The minimum touches setting will help you find more stable 
support/resistance levels, and the retracement% will help you adjust the sensitivity to turning points.  A 
lower retracement% will cause shorter-term turning points to be considered, whereas a higher number 
will get only longer-term pivots considered.   
  

Results Table 

The column labeled 'type' will list a 'P' and/or 'V' depending on whether a price or volume-based level 
had been hit.  The 'P Value' and 'V Value' columns will then show the values of the levels that have 
been hit.  As with the other scans, 'PTrnd' and 'VTrnd' show the price and volume trend slopes 
respectively.  'Range' is the price range (highest high - lowest low) over the period of the scan.  

  

  



TCScan+ 2.6.7 Help File 

109 

 

 

 

 

 

 

 

 

 

 

 

Reviewing Results 
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Reviewing Results 

The items that pass the filter criteria are listed in the results table, one at a time.  You can select 
various preferences to show the charts for each item in TScan+ and/or TeleChart while you are 
running the scan or reviewing the results.  A description of the specific results that each scan type can 
produce is given in the help section for each scan type. 

 

 Popup Menu  Right-clicking the results table will bring up the context menu shown below.  This 
allows easy access to the operations described below.  When you right-click on the title bar an 
abbreviated version of this menu will appear. 

 

 Sorting Results  When the scan is complete, the results will be sorted from A to Z by item 
name.  You can sort the results by any other column by left-clicking on that column 
heading.  Repeated clicking of the column heading will reverse the sort order for that 
column.  Alternatively, you can hold down the SHIFT key while clicking on the title bar of the 
results list.  This will open a form allowing you to sort by two columns at the time.   



TCScan+ 2.6.7 Help File 

111 

or   

 Highlighting Results  Rows in the results table can be highlighted in yellow by right-clicking them, 
or by pressing the F or Y keys.  Repeating your action will remove the highlight.  You can also 
highlight in Red, Green and Blue, by pressing the R, G and B keys respectively. Right-Clicking 
anywhere on the column headings will move all the highlighted items to the top of the table.  Once 
your items are highlighted you can choose to save only them when saving your results.  

 

 Copying Results  You can copy all or a portion of the results to the Windows Clipboard by 
clicking on a cell with the left mouse button and dragging across to the last cell in your 
selection.  Then while holding down the CTRL key, press C on your keyboard.  

 Finding Items  Pressing the J key will bring up a box allowing you to enter the name of the item 
you are interested in.  If found, the item's row will be scrolled to the top of the list.  

 Opening Charts  You can review the items in your results on a chart for that item, and also by 
opening the item up in TeleChart.  You can choose to use one or both of these methods in the 
Preferences menu.  Once the preferences are set, the charts can be opened by double-clicking on 
a row with the left mouse button or by pressing the Enter key when you are on any particular 
row.  You can also step through the list of items using the SPACE (forward) and BACKSPACE 
(backwards) keys.  Pressing the T key will open the stock in TeleChart, whether or not you have 
the open in TeleChart preference set.  Pressing Ctrl-T will open the item in TeleChart with the 
program items copied into it.  These commands are also available from the right-click menu.  
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 Printing Results  Pressing the Print button on the bottom of the main form or selecting Print Scan 
Results from the File menu will open the form shown below, which will allow you to print some or 
all of your scan results.  The items in the Data to Print section are equivalent to the items shown 
on the Preferences form.  The Items to Print section allows you to select which highlighted or un-
highlighted results you want to print.   

 

 Saving Results  Pressing the Save button on the bottom of the main form or selecting Save Scan 
Results from the File menu will open the form shown below, which will allow you to save the 
information in the results table to a file.  You can choose whether to save all your results or only 
highlighted ones.  You also have two file format options for saving:  

1. Names only:  Saving only the item names is useful for allowing you to import the results of 
your scan into TeleChart. You do this by saving your results in Names-Only format to the 
TeleChart directory.  Then use TeleChart's Import Symbols from List menu item under the 
WatchList menu to import the list into TeleChart.  

2. Names and Results:  Saving the results and filter values is useful for reviewing all the data 
later. The file format is a comma separated text file, which is a standard format easily opened 
in Microsoft Excel.  
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 Saving Multiple Chart Pictures  Selecting Save Chart Pictures from the results list popup menu 
will bring up a form allowing you to save chart pictures for multiple items in the results list.  You 
can access the same command from the Chart's File > Save Chart Pictures for Results List menu 
or the File > Save Chart Pictures menu on the main form.  

  

The layout of the form is similar to those above, in that you can choose whether to save pictures 
for all your results or only highlighted ones.  There also are options to provide a naming template 
for the files, the directory where to save them and the file type.  Hovering the mouse over the 
Naming box on the form will bring up popup help on the naming format, as shown below.  As an 
example, if MSFT is in your results list and you use the naming template 'DATE1 SYMBOL' (the 
default) as shown in the above, the file will be called '09-08-08 MSFT.png'.  Note that you can add 
any extra text you like anywhere in the template.  For example changing the naming template to 
'Test Scan DATE1 (SYMBOL - NAME)' will create a file called 'Test Scan 09-08-08 (MSFT - 
Microsoft Corp).png'  
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Charting 
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Charts 

TCScan+'s charts allow you to graphically review the items passing your filter criteria.  You can specify 
preferences to have charts displayed during the scan, after the scan is complete and also whether to 
open the charts in TeleChart at the same time.  The chart will automatically display items relating to 
the scan type you are running and you can also draw additional objects on it, which will be retained 
until you delete them.  Various actions can be executed by selecting items from the main or right-click 
menus, and by using shortcut keys or the toolbar buttons. 

 

Navigation  

The toolbar buttons and shortcut keys will allow you to navigate through your stock's data on the 
chart.  The behavior of the navigation buttons is different from what you may be used to from other 
charting programs.  When you click one of the buttons, TCScan+ will actually change the appropriate 
parameter (e.g. lookback period) on the main TCScan+ form, then rerun your current scan using the 
new parameters.  However, it runs the new scan with your general filter settings ignored.  It does this 
because it is likely that as you, for example, move back in time, your current filter settings, like number 
touches to a line, will not be met - and so a line would not be found. Because of this behavior you will 
notice that while you are navigating on the chart, the other items in your results list will be grayed out 
to indicate the new settings shown on the main form do not apply to them.  When you move to a new 
item in your results list or click within the results list, the settings you had before the chart navigation 
began will be restored.  Another consequence of the way TCScan+ reruns the scan with each 
navigation change, is that chart navigation may not be as quick as you might expect, especially with 
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certain scans like the Pattern one in Editable Patterns mode.  If this is a problem use the modifier keys 
(Shift, Ctrl and both Ctrl and Shift) to increase the step size taken between changes. 

Time Frame  You can change the chart time frame by clicking on one of the three 'T' buttons on 
the toolbar.   will move down in time frame (monthly > weekly > daily) and  will move up in 
time frame.  Clicking  will open a list from which you can select the time frame. You can also 
select the time frame by holding down the Ctrl key and clicking D (daily), W (weekly), M (monthly), 
Q (Quarterly), Y (yearly) or the numeric keys (also while holding down Ctrl.)  The numeric keys will 
specify the number days per bar, e.g., weekly charts are 5 days per bar.  

Panning (Left/Right)  Clicking one of the left/right arrow toolbar buttons will move the chart left or 
right by one bar.  If you hold the Shift key down while clicking, the movement will change by 5 bars 
instead of 1.  Using Ctrl will change by 25 bars and using both Ctrl and Shift will change by 50 
bars.  These buttons will actually be changing the shift value on the main form.  If you keep the 
button pressed down, the chart will scroll until the button is released, or until the new conditions 
cause the stock to fail your scan criteria (see the introduction to Navigation above.)  The actions of 
these buttons can be duplicated using the left and right arrow keys on your keyboard (including 
the Shift/Ctrl modifiers to speed up movement.) You can also click the S key to bring up a dialog 
box allowing you to enter the exact number of shift bars required. When using a shift value greater 
than 0, you can choose whether to display bars to the right of the scan date, i.e., bars within the 
shift period, by selecting 'Shift Bars Visible' from the Change menu.  A vertical red dotted line will 
be drawn to indicate where the shift period starts.   

Number Bars on Chart  Clicking or  will zoom in (less bars on chart) and zoom out (more 
bars on chart) respectively.  This will actually be changing the lookback period on the main 
form.  As described above, keeping the button depressed will continue increasing or decreasing 
the number of bars on your chart.  Also as described above, you can use the Ctrl and/or Shift keys 
to speed up movement.  The function of these buttons is duplicated by the [ or , and ] or . keys on 
your keyboard.  You can also click the D key to bring up a dialog box allowing you to enter the 
exact number of bars required.   

Price Scaling  Clicking  on the toolbar, pressing Ctrl-L or selecting Scaling from the Change 
menu will toggle between normal and logarithmic price scaling.   

Revert  After you have used the above buttons to scroll through the chart data, you can revert to 
the way the chart initially appeared before you did any time frame, bar count, etc. changes to it by 
clicking the   button. You do not need to do this to progress to the next item in your scan list as 
TCScan+ will automatically do that, but some times it is useful to see where you started.  

Chart Operations  
 

Saving Charts  Charts can be saved in various picture file formats by clicking  on the toolbar or 
selecting Save Chart Picture from the File Menu. Charts for multiple items in the results list can be 
saved at once by selecting Save Chart Pictures for Results List from the File menu.  Further 
details on this option are described in the Reviewing Results section.   

Copying Charts  To paste a picture of the chart into another application select Copy Chart Picture 
to Clipboard from the File Menu. 

Printing Charts  Pressing the P key or clicking  will bring up the print settings box, allowing you 
to print the chart to your printer.  You can also select Print Chart from the right-click or File menus. 

Opening Charts in TeleChart  Select Open in TeleChart from the View menu to display the 
current item in TeleChart.  Other TeleChart options are also available from the results list.  

Zooming Clicking  on the toolbar, pressing the Z key or selecting Zoom In from the View menu 
will put you into zoom mode.  The cursor will change to a magnifying glass icon allowing you to 
click and drag the region you want to zoom into.  You can also just click the chart to zoom in by a 
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set amount (or hold the Alt key down while clicking to zoom out.)  To zoom out again, you can 
click the X key or select Zoom Last from the View menu to toggle between the current zoom and 
the previous view.  Clicking the Q key or selecting Zoom All from the View menu will zoom out to 
the whole original chart. The zoom last and zoom all function are duplicated by holding down the 
Shift and Ctrl keys, respectively, when clicking on the zoom toolbar button.   
 

 
 

CrossHair Cursor Clicking the  toolbar button, pressing the O key or selecting Crosshair Cursor
from the View menu will toggle between the regular chart cursor and a crosshair cursor.   

Chart Properties  
 

Changing Colors  You can change most of the colors used on the chart by pressing the C key, 
selecting Change Colors on the right-click menu or pressing the toolbar button .  To prevent 
confusion, TCScan+ shows only the chart colors for the specific scan type you are currently 
running. 

 
Select a new color by clicking on the applicable color swatch.  Click Apply to apply the new colors 
to the chart without closing the form.  Click OK to apply the colors and close the form, or click 
Cancel to close the form without saving any color changes.  Click Defaults to return all colors for 
the specific scan type to their default first-install values.  

Chart Size  You can increase or decrease the size by dragging the border of the chart, by 
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pressing the Page Up or Page Down key, or by selecting from the View menu.  You can make the 
currently-displayed chart size the default by selecting Save Current Chart Size as default on the 
right-click or File menus.  You can return a chart to its current default size by selecting Return 
Chart to Default Size from the Right-Click or View menus.  You can also return it to its first-install 
default size using File > Return default size to install setting.    

Chart Margins You can adjust the amount of extra space added to the top, bottom and right 
margins by selecting the appropriate item from the Change menu or under Change on the Right-
Click menu.  The changes you make will apply to all future-drawn charts, until you change them 
again.  You can also use the left and right arrow keys to adjust the right margin, the up and down 
keys to adjust the bottom margin, and the up and down arrow keys along with the Ctrl key to 
adjust the top margin.  You can hold the Shift key down along with the above combinations to get 
larger increases in the changes made.  Note that the chart margins might not always move when 
you change the setting or press the arrow keys.  This is a result of how the axes are scaled and 
numbered - just repeat the action until movement occurs.  

Price Bars You can click the  toolbar button, press the E key or select Bar Type from the 
Change menu to toggle between regular OHLC and candlestick bars.  This option can also be 
accessed via the preferences form.  Clicking the numeric keys from 0 to 9 will change the number 
of real bars to display per bar.  This provides a different function to changing the time frame 
above.  In this case, only the chart is affected - the scan is not changed.  Also, this function 
applies in addition to the time frame, so if you press 5 and the time frame is weekly, then each bar 
on the chart will actually summarize 5 weeks of data. You can also access this function by 
selecting Days per Bar from the Change menu.  The latter method allows greater than 9 days per 
bar.  

Information  The item name and date range is shown on the title bar when the chart is opened or 
the item is changed.  Moving the mouse cursor over the chart will change the caption to show the 
date, value and Open/High/Low/Close at the mouse cursor position on the chart.  Summary 
information is also printed at the bottom of the chart. When drawing lines, the caption bar will 
change to include the change in price (dP), change in bars (Bays) and Strength of the move 
covered by the line.  The Strength is calculated as the square of the change in Price divided by the 
number of Bays covered by the move.  It is an indication of the strength of a move and was 
developed and described by Alex Saitta in the October 2000 issue of Technical Analysis of Stocks 
and Commodities Magazine.  The idea is that as succeeding up or down moves lose Strength 
then a major reverse move is likely.  

Scan Details  You can click the  toolbar button, press the G key, or select Scan Details Text 
from the View menu to show a summary of the scan details (actually a copy of what is shown in 
the results table) on the chart.  

User-drawn Objects (Lines, Circles, Fib Levels, Fib Spirals) 
 

Copying Program Objects  Program-drawn objects can be copied as user-drawn objects by 
pressing the W key or selecting Copy program objects from the Edit menu.  For example, if you 
have run a trendline scan, you can press W on the chart and the trendlines found by the program 
will be copied onto your chart, so when you do another scan type they will still be there.  

Creating Objects  

 Lines can be drawn by clicking and dragging with the left mouse button.  They can be 
constrained to horizontal or vertical by holding down the Shift key while drawing the line.   

 Circles  and ellipses can be drawn by clicking and dragging with the left mouse button while 
holding down the Alt key.  Small circles can be created by holding down the Alt key and clicking 
on the chart.  Circles can be constrained to perfect circles (rather than ellipses) by holding the 
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Shift key down at the same time as the Alt key.  

 Fibonacci Level Lines can be drawn by clicking and dragging with the left mouse button while 
holding down the Ctrl key.  The specific levels shown for user-drawn Fibonacci levels are 
identical to those listed on the Fibonacci Scan tab.  

 Fibonacci Spirals can be drawn by clicking and dragging with the left mouse button while 
holding down both the Ctrl and Shift keys.  

Selecting Objects  User-drawn objects can be selected by clicking on them.  Once an object is 
selected, it will have small squares called anchors shown on it.  These anchors can be moved to 
move the start and end points of the object, or the object can be dragged as a whole by clicking 
and dragging between the anchor points.  Note that to select Fibonacci Spirals you need to click 
on the pivot line used to create the Spirals.  You can switch from one selected object to the next 
by pressing the N key.   

Adjusting and Modifying Objects  Once you have selected an object, you can move its anchor 
points by clicking on them and dragging.  You can also open a form to edit the object's settings by 
double-clicking on the object, clicking Modify Selected Object in the Edit Menu, pressing the A key 
while the chart is selected or selecting from the Right-Click menu.  This form will allow you to 
exactly specify the object's end-points by entering their values or by clicking on the arrow buttons 
to the right of the text boxes (see picture below.)  Holding down the Ctrl key while clicking will 
allow fine adjustment and holding down the Shift key while clicking will allow coarse adjustment.  

This form also allows you to change the colors and line settings of user-drawn objects.  For User-
drawn Fibonacci Levels, this form allows you to choose whether to display the pivot lines, whether 
to place the level values on the left, middle or right of the level lines and the ability to invert the fib 
levels, i.e., swap the start and end points of your pivot line.  You can also independently specify 
line types for the pivot and fib lines.  For trendlines, you can specify whether the line should 
extend across the chart and the line styles for both the main and extended lines.   

 

Deleting Objects  Once you have selected an object, you can delete it by pressing the Delete 
key, or by selecting Delete Selected Object from the Edit menu, or by selecting Delete under 
Selected Object on the Right-Click menu.  You can also delete all objects of a certain kind, or 
delete completely all objects by selecting the appropriate item under the Edit menu.  Finally, you 
can delete the last-drawn object without entering Selection Mode, by pressing the delete key in 
combination with the key used to draw the object.  So for lines, just press the Delete key, for 



TCScan+ 2.6.7 Help File 

120 

Circles press Alt and the Delete key, for Fibonacci levels press Ctrl and the Delete key. and for 
Fibonacci spirals, press the Ctrl, Shift  and Delete keys   

Saving Objects  A collection of user-drawn objects can be saved by selecting Save chart objects 
from the File or Right-Click menu, or by pressing the V key.  You can then load these objects 
using Load chart object file from the same menus or by pressing the L key.  

Duplicating Objects  You can duplicate the currently-selected object by select Duplicate Selected 
Object from the Edit or Right-Click menus, or by pressing Ctrl-C.  

Scaling Conversion  User-drawn lines first drawn on a chart with linear (arithmetic) scaling, will 
be correctly redrawn when displayed on a chart with logarithmic scaling and vice versa.  This 
prevents confusion when switching from one scaling type to another.  For example, the first chart 
below shows two trendlines drawn on a chart with logarithmic scaling, and the second chart shows 
the same lines displayed on a chart with arithmetic scaling.
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Back-Testing 

TCScan+ allows you to see how well your scan settings have worked in the past through its back-
testing functionality.  You specify various trading criteria on a back-test options form and the program 
uses them to enter and exit positions on each of the items that passes the particular scan you are 
running.  When your scan is complete, a summary of the profitability of all positions taken can be 
displayed.  Individual statistics, like %profit or days in trade, will be listed within the results table.   

There are two important points to note regarding the back-testing.  First, all back-testing statistics are 
calculated on a daily basis, irrespective of your trading time frame.  Second, the only back-test setting 
that is stored in a settings file is the direction of the trade you want to take, i.e. long or short.  All other 
settings are remembered from your previously-used settings. 
  
To see back-testing results you need to: 
 
1. Run the scan for a date some time in the past.  This is done by changing the Shift value on the 

main form.  TCScan+ will take a position one day after the date of the scan and stay in the position 
until one of your exit criteria are met or until it reaches the current date.   So, for example, if you 
have a shift of 100 days and very loose exit criteria, it could potentially stay in the trade for the full 
99 days from the day after the scan date up to the present. 

2. Have back testing enabled.  This is the default behavior whenever you enter a value for Shift 
greater than 0, but you can disable it on the back-test options form. 

3. Enable one or more statistics to display.  Some are selected by default and you can modify them 
as you require. 

4. Specify position direction and size and one or more entry and exit methods, so TCScan+ knows 
how to enter and exit positions. 

5. Allow shift days to be shown on your charts.  This is not necessary to have trading statistics 
calculated, but if you want to see an arrow on the chart showing where the position was exited 
then you need to show the shift days - see below for an example.  The vertical red dotted line 
shows the scan date (where the trade was entered) and the cyan exit arrow shows where the 
position was closed. Trade statistics from the results table can also be shown on the left of the 
chart. 
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Back-Test Options 

The back-test options page is displayed by selecting Back-Test Options from the Options menu or by 
pressing the Shift-F3 key combination.  An example is shown below. 

 

General Settings 

 Position: specifies whether to take a long or short trade position.

 Calculate Back-Test Statistics: determines whether back-test statistics will be calculated ad 
displayed. 

 Show profit summary at end of scan: if checked, will cause a form to be shown at the end of a 
scan summarizing all the positions taken.  An example is shown below. This form can also be 
shown from the view menu after the scan.
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 Don't show summary for single scan: if checked, a trade summary form will not be shown when 
a single item scan is run. 

Entry Options 

 Open: enter trade at the open of the day following the scan date.

 Close of Previous Day: enter trade at the close of the day of the scan date.  Use this option if you 
run your scan just before the close of the day and enter positions then, otherwise use the entry at 
open instead. 

 % or $ Above Previous Close: enter the percentage or dollar per share entry point above the 
close of the day of the scan date. For example, if the close is at $10, then a setting of 5 with the % 
option checked would mean an entry at $10.50.  TCScan+ will not enter a position if the high of 
the day following the scan date does not cross the calculated entry point. Use this option if you 
only want to enter positions that start out confirming your expectations.

Exit Options 

You can enter one or more of the following criteria for closing the position.  For each day in the trade, 
TCScan+ will calculate the specified exit point for each stop type and will close the position when any 
one is hit.  To ignore a stop type, leave empty the box that holds its value. 

 % Stop Loss: exit the position if price falls to a point where percentage losses exceed the 
specified number.  For example, you enter a position of 100 shares at $5 and have a % Stop Loss 
of 10.  If the price per share falls below $4.5 the position will be closed.  Since intraday data is not 
available, TCScan+ has to guess about price movement within the bar.  If a bar gaps open below 
the stop point, it will take the exit at the opening price.  If the low of the bar is under the stop point, 
it will exit at the stop point. 

 % Profit Protect: similar in nature to the stop loss, the profit protection calculation keeps track of 
the most profitable point in your trade to date and exits if the price falls below the specified 
percentage off the most profitable point.  For example, you purchase 100 shares at $5 and have a 
5% profit protection stop in place. After a few days price reaches a high of $7 and then starts 
falling.  The position will be closed if price falls below $6.65 (5% off $7.)  As for the stop loss, if a 
bar gaps open below your profit protection point, it will take the exit at the opening price.  If the low 
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of the bar is under the profit protection point, it will exit at the profit protection point. 

 $ Stop Loss: this works the same as the percentage stop loss, but instead sets the stop at a fixed 
dollar loss.  For example, with 100 shares purchased at $5 and a $75 stop loss, the position will 
be exited if the price falls under $4.25.  As with the % Stop Loss, the actual position loss will be 
the specified $ Stop Loss plus slippage at the entry and exit plus possible gap-down losses (if 
price opened under your stop point.) 

 $ Profit Protect: allows a fixed total dollar loss off the maximum profitable point in the position 
before the position is closed. 

 Time Stop: Exits the position at the close after the specified number of days. 

 Volatility Stop: Will use the settings you have defined in the Volatility Stop scan to exit 
positions.  You can choose which of the 3 stop levels to use for the exit (1 = tightest, 3 = loosest) 
or you can check the 'Transition Vol Stop' box to get the stop to start at the loosest level and then 
be changed to the next tightest level after the number of days specified in the 'Number Days' text 
box.  For example, if you specify 5 for the number of days, the stop will start at level 3, the loosest 
stop, and then will change to level 2 after 5 days and then to level 1 after 10 days in the trade and 
will stay at that level until the trade is exited.  

 Allow Exit on First Day: This option allows you to specify whether a position can be exited on the 
day it is taken (in other words the day after the scan date.)  TCScan+ tracks the high of the bar as 
the most profitable point, and the low of the bar as the least profitable.  It is possible, therefore, 
that if an entry is taken at the open of a large-range bar either the profit protection or stop loss 
point could be hit on the same day (as it can be on any other day.)  An example is shown on the 
next page.  The position was entered at the open price of $3.59 and the high and low were at 
$4.88 and $2.64 respectively.  The low is 26% below the entry point, so if a 10% stop loss was 
held it would have been triggered at $3.23.  Likewise, if a 5% profit protection stop was in place, it 
would have been triggered at $4.64.  TCScan+ checks the profit protection point before the stop 
loss, so would have recorded a 29% profit for this position, minus slippage.  If you did not select 
the 'Allow Exit on First Day' box, then the position would not have been closed on this 
day.  Instead, it would have been closed on the following day at a lower profit, because that day 
opened below the profit protection point, so would have been closed at the open price of $4.35 
instead of the $4.64 profit protection point. 

 Apply stops at close only: When checked, TCScan+ will only consider the closing prices in 
deciding whether to exit a position.  In the above example, the stop loss would not have been 
triggered because the close was not lower than $3.23.  However, the profit protection point would 
have been hit at the close of $4.07 because it was below $4.64. 
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Position Size 

 Number Shares: purchase the same number of shares for every item.  This means that a lower 
cost position will be taken in lower priced stocks than higher priced ones. 

 Dollar Amount: purchase the same total dollar cost of shares for every item, so more shares are 
purchased for lower priced items than are for higher priced ones.

Slippage 

 Percent: add a fixed percentage to the total cost of the purchase and subtract the same 
percentage from the sale when the trade is closed.  For example, if you take a position of $500 
and sell it for $700, and have specified a 1% slippage, it would be equivalent to purchasing at 
$505 and selling at $693.  Use the slippage section to account for commissions and slow fills. 

 Dollars: add a fixed dollar amount (not per share) to the purchase cost and subtract the same 
from the sale price. 

 

Show in Results Table 

Check one or more of the trade statistics to display them in the results table. 
  

 
  
The meaning of these items (along with their abbreviation shown in the results table) are as follows: 
  
 Number Shares (Shares): The number of shares of each items purchased.  This number is either 

specified directly in the Position Size section or calculated from the dollar value of the position 
specified there. 

 Entry Price (Entry$): The exact price at which the position was entered. 

 Exit Price (Exit$): The exact price at which the position was exited. 

 % Profit or Loss (%Profit): The percentage change between the exit and entry price for long trades 
(vice versa for short trades), adjusted for slippage.  

 Annualized % Profit or Loss (%Annual): The same as above, but with the percentage adjusted for 
the number of days in trade to provide an annualized percentage change.  This is useful for 
comparing different trades, each of which have a different duration. 
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 $ Profit or Loss ($Profit): The difference between the dollar value of the position at the entry and 
exit points, adjusted for slippage. 

 Maximum %Profit/$Profit (Max%/Max$): Equivalent to the profit numbers above, but based on the 
highest high (long) or lowest low (short) over the trade period instead of the exit price. 

 Maximum %Drawdown/$Drawdown (DrDown%/DrDown$): As above, but provides the maximum 
drawdown in the position.  For a long position, this is the difference in position value between the 
entry and lowest low over the trade period.  For a short position it is the difference between the 
entry and highest high.  This statistic indicates how wide you would need to place your stops to not 
get stopped out of the position. 

 Days in Trade (TrdDays): The number of days from the trade entry to its exit. 

 Reason for Exit (Exit Reason): An abbreviated reason why the trade was exited will be shown in 
the results list.  A summary of the abbreviations is provided below and further details are available 
in the Exit Options section above.   
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Shortcut Keys 

Main Form 

Key Modifier Action 

F1   Open Help 

F2 Ctrl Adjust form size and specify default size 

F2 Shift Return form to default size 

F2   Toggle between Results Only and Whole Form mode 

F3 Ctrl Ignore/Use filter settings 

F3 Shift Open Back-Test options page 

F3   Open preferences page 

F4   Find list in tree 

F5   Reload all lists 

F6 Shift Expand list tree 

F6   Collapse list tree 

F7   Clear all checks in list tree 

F8 Ctrl Display chart for a specific (new) item - Arithmetic Scaling 

F8 Shift Display chart for a specific (new) item - Logarithmic Scaling 

F8   Show chart for currently-selected item in the results list 

F9 Ctrl Run Scan for a single item 

F9 Shift Run Scan for a list of items 

F9   Start / Stop Scan 

F11 Shift Save Scan Settings 

F11   Load Scan Settings 

F12   Save Scan Results 

F12 Shift Export Scan Results to TeleChart 

P Ctrl Print Scan Results 
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Results List 

Key Modifier  Action 

B    Highlight item in Blue 

F or Y    Highlight (Flag) item in Yellow.  Pressing F again will un-highlight. 

G    Highlight item in Green (equivalent to Ctrl-F) 

J    Find item in results list 

L    Export scan results list to TeleChart 

R    Highlight item in Red (equivalent to Shift-F) 

T       Open item in TeleChart 

T Ctrl  
Open item in TeleChart with program lines copied to TeleChart 
(This function is only available for Trendline, Channel,  Fibonacci 
level and Support level scans) 

Arrow keys        Step through the results, without displaying any charts 

Backspace        Step backward through the results (Equivalent to Ctrl-Space Bar) 

Enter         Display chart for the current item in the results list (See Options) 

Space Bar       Step forward through the results 

Space Bar    Ctrl  Step backward through the results (Equivalent to Backspace) 

Space Bar    Shift  Step to next flagged item 
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Charts 

Key Modifier Action 

1,2,3,…    Change number of real bars to display per bar 

1,2,3,… Ctrl  Change time frame to 1-day, 2-day, 3-day, etc. (e.g. 5-day is weekly) 

A    Open form to allow adjustment/modification of selected object 

B    Open entry box to adjust Bottom margin 

C    Change colors 

C Ctrl  Duplicate selected chart object 

D    Change number bars of data shown on chart 

D Ctrl  Change to Daily time frame 

E    Toggle bar type (Candles or OHLC) 

G     Toggle display of scan results on chart 

H    Change percentage volume bar height on charts 

I    Change number of bars to show following the scan date (visible shift 
bars) 

L   Load user-drawn objects file 

L Ctrl  Toggle between log and linear price scaling 

M    Open form to allow adjustment/modification of user-drawn object. 

M Ctrl  Change to Monthly time frame 

N    Select next object 

O   Toggle crosshairs display 

P    Print Chart 

Q   View the whole chart (Used after Zooming In) 

Q Ctrl Change to Quarterly time frame 
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Key Modifier Action 

R    Increase Right margin 

R Shift  Decrease Right margin 

R Ctrl  Open entry box to adjust Right margin 

S     Open entry box to adjust shift bars 

T    Open current item in TeleChart 

T  Shift  Open entry box to adjust Top margin 

T Ctrl  
Open item in TeleChart with program lines copied to TeleChart  (This 
function is only available for Trendline, Channel, Fibonacci level and 
Support Level scans) 

U    Return chart to default size 

V   Save user-drawn objects to a file

X   Toggle between current and last Zoom size

Y Ctrl Change to Yearly time frame

W   Copy program-drawn object (Trendlines, Channels, Fibonacci Price 
Levels or Support Lines) onto the chart as user-drawn objects 

W Ctrl Change to Weekly time frame

Z   Enter Zoom Mode (Click & Drag to Zoom In)

[ or ,    Pan the chart left by 1 bar (or with shift by 5, Ctrl by 25 or Shift+Ctrl by 
50) 

] or .    Pan the chart right by 1 bar (or with shift by 5, Ctrl by 25 or Shift+Ctrl by 
50) 

Back Space    Show chart for previous item in the results list 

Delete    
Delete selected object, or when nothing selected, delete last line drawn, 
last circle drawn (with Alt), last Fib levels drawn (with Ctrl) or last Fib 
Spirals drawn (with Ctrl and Shift) 

Down Arrow    Move Bottom margin Down 

Down Arrow Ctrl  Move Top margin Down 

Left Arrow    Move chart data left by 1 bar (or with shift by 5, Ctrl by 25 or Shift+Ctrl by 
50) 

Page Down    Decrease chart size by 10% 
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Key Modifier Action 

Page Up    Increase chart size by 10% 

Right Arrow    Move chart data right by 1 bar (or with shift by 5, Ctrl by 25 or Shift+Ctrl 
by 50) 

Space    Show chart for next item in the results list 

Space Ctrl  Redraw chart without scan objects (e.g. MoneyStream angle lines) 

Up Arrow    Move Bottom margin Up 

Up Arrow Ctrl  Move Top margin Up 
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Tips for Faster Scans 

Reduce the number of lookback days in the scan. 100 (trading) days of data (5 months) should be 
sufficient for most scans (depending of course on your trading style.) 

Reduce the number of stocks scanned. You can scan all the stocks in TeleChart if you like, but it 
would be best to narrow your search to certain sectors, or to your own watch lists.  

Narrow down your filter criteria - reduce the price and volume range of the stocks you are 
interested in trading.  

If you have it on, turn off the Show Charts while scan is running option. With this option set the 
scan time will be greatly increased. 

In Pattern Scans, use the Built-In Pattern Mode instead of the Editable Pattern Mode.  Also, to 
display charts faster, turn off the Show Past Patterns option. 
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Registration 

The registration form that appears when TCScan+ starts is used to purchase TCScan+ and register it 
for unlimited use.  You can access the same form by selecting Register from the File menu.  During 
your trial period, you can run the program by clicking the Run Program button, or purchase it by 
clicking the Purchase button. 

 

The Purchase Process 

1. Click on the Purchase button to be directed to the payment entry page on our web site.  You 
need to have an active internet connection before pressing this button.  If for some reason you 
do not reach our site, then open your web browser and connect to 
http://www.tcscanplus.com/Purchase.htm instead.  

2. Once you have completed the payment process you need to send us your software code.  We 
will then reply with the corresponding Unlock Code that will allow unlimited use of TCScan+.  

3. Press the Email Code button to copy your code into your computer's memory so you can 
paste it into an email.  Open up a new email and paste the code into it by holding down the 
Ctrl key then pressing the V key.  Add your name, address and purchase date to the email, 
address it to registration@tcscanplus.com and send it to us.  Shown below is an example of 
how the email should look (your code will be different.)  
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4. Once we have confirmed your purchase and received your software code, we will email you 
an Unlock code.  Open the email we send you, and highlight the code.  Hold down the Ctrl key 
then press the C key - this will copy the code into memory.  Start up TCScan+ and when the 
registration form appears, click in the box next to Unlock Code, then hold the Ctrl key down 
and press the V key.  This will paste the code into the box. Press the Unlock button. 

5. A popup form will appear, which will allow you to enter your name.  The name you enter will 
be displayed on the Help > About form and the splash screen that shows when the program 
opens.  Click OK when you are done.  You may change the name you entered in this form any 
time later, by opening the registration form and reentering your Unlock Code.  You can open 
the Registration form by going to the File menu and clicking Registration.   

 

  

  


